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1.0 Problems and Solutions

The SWAMP Advisor expert knowledge system contains comprehensive information and
advice for preparing Quality Assurance Project Plans (QAPPs) that will meet all of
California’s Surface Water Ambient Monitoring Program’s (SWAMP) criteria. It uses
Java “applets” with your computer’s browser and information that “pops up” in your
browser. Therefore, your browser must be configured to accept “pop ups” and Java
programming (which is free) must be installed on your computer. Most common
problems are solved by employing solutions to these two requirements as described
below.

1.1 The Left Side of My Screen Appears Blank

Solution: Allow Java Applets to Function in Your Browser or Add Java if it is Not
Available.

If you do not see the opening text and menu of the expert system in the left panel then
your browser is not loading applets. These are under the control of your browser and you
will either need to load JAVA software or configure your browser to accept applets if you
already have Java. Follow the steps below:

1. Go to "Tools™ in your browser menu.
2. Select "Internet Options™ and when that menu comes up select the "Security" tab.
3. Select the "Custom Level™ button under your browser security tab.

4. Scroll down the various options until you reach "Microsoft VM" and under that will be
a heading "Java permissions."” If "Disable Java" is selected then the following error
message will appear in the left panel of your monitor: "The expert system would be
running here but your browser has Java Applets disabled or does not support Java
Applets.” If this is the case, then click on "Medium Safety” under "Java permissions.” If
you make a change to your browser be sure to then click on the "OK" button to activate
the change.

5. Next, scroll further down the Custom Level until, near the bottom, you reach



"Scripting of Java applets”. Make sure that this option is checked "Enable." If it is not,
then change the setting to "Enable.” If you make a change to your browser be sure to then
click on the "OK" button to activate the change.

6. After completing any changes necessary to the "Security - Custom" settings then select
the "Advanced" tab in the Tools main menu. Scroll half way down this list of options
until you come to those marked "Microsoft VM" and place a check in all three options:
"Java console enabled (requires restart), Java logging enabled, and JIT compiler for
virtual machines enabled (requires restart)." Then you must click on the "OK" button to
activate the change.

7. After making changes to your browser Tools, close any programs you have running
and restart your computer. You should check the Tools changes that you just made to
make certain that the changes you intended to make were indeed made. After verifying
these changes you should be ready to retry the Internet link to the expert system.

8. If the above checks did not result in the applets loading in your browser then you may
need to update your JAVA program. Here is how you do that:

Uninstall the old Java program. Depending on your install, there may be more
than one program to uninstall. For example you may have to uninstall the Java
Runtime and the Java SDK. If you have the Java SDK, do not uninstall anything
until you check with your system administrator. You uninstall programs by going
to "Control Panel™ on your computer and selecting "Add or Remove Programs.” If
Java is present you should see it listed in alphabetical order. If it is not present
then, of course, you can't uninstall it.

Next, go to http://java.com/

On the right hand side is an orange button labeled ‘Java Software Download'.
Select it. This brings you to a second screen with an orange bar that says "Begin
Download" and this will be an automatic download.

You do NOT have to purchase Java on a CD. Instead, look for the online
download. Make sure you get the one for your operating system - but that could
be automatically selected if you use the automatic install. The automatic install
will download and install everything automatically. The manual install requires
you to perform the install after you have performed the download. When it asks if
you want the Plug-In, be sure to checkmark the box next to Internet Explorer (IE).

If you are using a browser other than Microsoft Explorer 6.0 then you should make
similar checks and changes to the appropriate tools that involve applets in whatever
browser you are using.



1.2 Competed Reports Do Not Appear in My Browser

Solution: Deactivate Your Browser’s Pop Up Blocker

If you have Pop Up Blocker software installed (from commercial sources such as
Earthlink, AOL, etc.) you will need to access that software's instructions to deactivate it.
This is to enable the SWAMP server to send text reports for your QAPP to your
computer.

However, if your browser deactivates pop ups automatically then follow these steps:

1. Go to "Tools™ in your browser menu.

2. Select "Internet Options™ and when that menu comes up select the "Security" tab.

3. Select the "Custom Level™ button under your browser security tab.

4. Scroll down to the option involving pop up blocking and check the option that will
allow pop ups. This usually involves one or both of the following:

1 To turn off the Information Bar for file downloads, in the Downloads section of
the list, under Automatic prompting for file downloads, click Enable.

2 To turn off the Information Bar for ActiveX controls, in the ActiveX controls and

plug-ins section of the list, under Automatic prompting for ActiveX controls,
click Enable.

1.3 Completed Reports Appear for a Second and Then Disappear

Solution: Enable Downloads in Your Browser.

If you select the Save to Print option in the SWAMP Advisor and you see that a file
apparently pops up and then immediately disappears before you can do anything about it
then you probably have one of the "Download” options in the security settings of your
browser checked as 'disable.’

To check and correct this problem please follow these steps:

1. Go to "Tools" in your browser menu.

2. Select "Internet Options" and when that menu comes up select the "Security" tab.

3. Select the "Custom Level™ button under your browser security tab.

4. Scroll down the various options until you reach the menu item for "Downloads." There



are usually three sub menu items and all of them should be checked "Enable."

1.4 Completed Reports Can Not Be Viewed Until Saved

Solution: Save the Report to Disk or Use a Different Browser than IE 7.
Microsoft’s Internet Explorer Version 7 (IE 7) currently causes this problem.

Heightened security in IE 7 doesn’t allow documents sent from the California computer
server to be viewed without first saving them. When a report is sent to your browser you
should see three choices: "Find" "Save" and "Cancel."

Your only useful option is to select "Save" and then give your file a name with the
extension of RTF on the end (for example: 7-QAPP.rtf or 14-QAPP.rtf, etc.). You are
going to save your draft file anyway so this is a small inconvenience in that IE 7 does not
let you first view your file (and perhaps edit it if you wish) before you save it.

1.5 SWAMP Advisor Does Not Fit My Monitor’s Screen Size (Too
Big or Little)

Solution: Modify your Computer’s Monitor Resolution

The SWAMP Advisor is best viewed using a monitor where your screen resolution is set
to 1024 x 768 pixels. This is because there are two frames and they should occupy your
entire monitor's screen at the specified resolution in order to avoid excess scrolling. If
you have a lower resolution you will have to do a lot of scrolling to read all of the
information that is presented to you. Even with the recommended resolution you will
sometimes need to scroll but this is kept to a minimum.

You can easily change your screen resolution if you determine that this is a problem. And
it is just as easily changed back to your initial resolution, should you want that, after you
have finished using the software. The change should take you less than a minute to
perform by following the instructions below:

1. Go to your Control Panel (often linked under My Computer or under Start).

2. Click on Display Properties.

3. Click on the Settings Tab in the Display Properties dialog box.

4. Set the Screen Resolution to 1024 x 768 pixels (either by sliding the bar or clicking on
the right side of the Screen Resolution indicator).

5. Click on “Apply” or on “Okay” and the new screen resolution will be applied. You



may get a message asking you to confirm that you want to change the screen resolution
and, if so, click on “Yes”.

1.6 CoverPage.doc Does Not Start Appending

Solution: Re-save the file to the folder where your QAPP files reside.

The CoverPage.doc file that you download from the California server when you are ready
to prepare a Master QAPP document has a “macro’ that automatically finds and appends
all of the 21 individual document files from the SWAMP Advisor that you have saved.
However, sometimes when you shut down your computer and then restart it and activate
the CoverPage.doc file then the macro doesn’t find the files that it is supposed to append.

If this happens then re-save the file CoverPage.doc being careful to make sure that it is
re-saved to the folder where all of your individual QAPP document files are saved. This
simple operation should then enable the macro to correctly function and automatically
append all of the document files to make your Master QAPP file.

1.7 CoverPage.doc Stops Appending Before Finishing

Solution: Rename the Missing File or Find and Save It.

If the CoverPage.doc file starts to append your individual QAPP files to make a Master
QAPP file and suddenly stops and displays an error message then it can’t find a file that
is needed to complete the Master QAPP document.

The error message that will pop up on your screen displays:

“Run-time error *5174’:

This file could not be found.

(Missing Filename appears in parenthesis at the bottom of the message)
A missing file may be caused either because it is not present in the folder where you
saved the file CoverPage.doc or because it has been named incorrectly. Incorrect file
names are usually the result of a typing error during the saving of the fie or, perhaps, the
last three letters are in caps (i.e., Xx-QAPP.RTF instead of x-QAPP.rtf).
In any event, the error is usually able to be quickly found and corrected because the error
message shows you which file name is causing the problem.

2.0 Background — Expert Systems and the SWAMP Advisor

Expert knowledge systems are computer programs will give a human expert’s advice



with a particular topic. Thus, they emulate a human expert’s decision-making process in a
particular domain of knowledge. Thousands of expert knowledge systems have been
developed around the world for assistance over a wide range of topics and subjects.
Expert systems often have dual uses as they assist in the training of individuals in a
particular subject, and they also offer fast, effective on-the-spot advice in the form of
easy to answer questions.

Writing Quality Assurance Project Plans (QAPPS) for environmental monitoring projects
requires highly technical training and specialized knowledge. For example, monitoring
projects may require knowledge that involves:

1

Sampling — determining whether to collect representative samples or judgmental
samples (perhaps reflecting “worst” or “best” conditions at a site and knowing
that the answer depends on the question(s) that the project is designed to answer.

Sample Containers — correctly selecting the right container(s) for different types
of contaminants (organic, inorganic, volatile compounds, compounds sensitive to
light, etc.) each of which require different kinds of containers (glass, plastic, etc.).

Sample Preparation — knowing how to correctly preserve samples, if necessary.
When to preserve samples and when not to? How to correctly store samples and
how long can they be stored?

Analytical Methods — answering questions such as how sensitive, how precise,
how selective (detecting a specific analyte or class in the presence of others
perhaps at higher concentrations), and how good does the analyte recovery need
to be?

Quality Control Samples — determining which quality control (QC) samples will
be necessary to provide answers on the quality of the data that will be collected.
For example, are QC samples necessary to differentiate between sample
contamination, and procedural errors, to calculate confidence levels for DQOs, to
measure bias from incomplete recovery, to measure imprecision, etc.

The above are some of the many interrelated components of QAPPs that directly or
indirectly affect each other. These are illustrated in Figure 2.1.
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Figure 2.1 - Relationships of Key Components of a Typical QAPP

The purpose of the SWAMP Advisor is to help users to write QAPPs in a shorter amount
of time and that will be acceptable the first time they are submitted for review. In
addition, another objective is to teach users why they are being requested to provide
certain information as well as being instructed how best to provide it.

Using the SWAMP Advisor to help write QAPPs will result in more scientifically rigorous
documents that will save Water Board staff time because they will be done correctly the
first time and not have to be rewritten and then reviewed again. Also, by causing the
users to think about why they are doing certain things (such as selecting analytical
methods) better alternatives may result instead of simply proposing doing the analyses by
rote and using the same methods that may have been used in the past with no other
considerations.

3.0 SWAMP Advisor Navigation and Use

In this section the important features that relate to the quick and easy navigation of the
expert system are summarized.

3.1 SWAMP Advisor Layout

When you start the SWAMP Advisor you will see a screen with two “frames,” as in
Figure 3.1 below. The expert system (which asks questions and provides answers and
advice) is in the left hand frame. In the frame on the right side is an “Explanation Screen”
in which additional information is provided. This additional information may include
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information about the question being asked or it may provide links to additional pages of
information, reports, figures and tables, and even other web sites. The explanation
screens automatically change depending on the content in the left hand side frame.

| Expert System Side | | E xp lanation Sid e

Text with a question at the top. Texi w il more in-dep i

explanations, exam ples,

* Select Answer #1 and advice.

e Select Answer #2
Links to m ore
information.

e Select Answer #3

-
e [ [Fesrt |
N aviga tion /-'

Buttons

Links to Advice

to
ex am ples to
copy and p aste.

Figure 3.1 - SWAMP Advisor Dual Screen Diagram

Click the bar labeled “Yes, I’m ready to enter the SWAMP Advisor” to start the program.
The first question asked is which Group of Elements you wish to work with. There are 24
“Elements” (or “sections”) to be completed in order to have a SWAMP-Comparable
QAPP and these are organized into three major groups:

1 Group A Elements (Numbers 1 - 9) involve ‘administrative functions’
2 Group B Elements (Numbers 10 — 19) involve data generation and acquisition.
3 Group C & D Elements (Numbers 20 — 24) involve data assessment.

These element groupings and topics follow U.S. EPA’s format. Note, however, that the
SWAMP Advisor combines questions involving Elements 15, 16, and 17 into one menu
selection. This is because of the interrelated nature of the questions and the information
being gathered. However, your answers are correctly placed in the individual sections of
the QAPP document where they reside (i.e., Sections 15, 16, and 17 respectively).

Also be advised that the SWAMP Advisor automatically produces comma-delimited
tables for Elements 12, 13, 14 and 16 at the same time that it produces tables 7.1 and
7.2 in Element 7. This is because the data that is provided from SWAMP QAMP
documents for the analytes that you select is also used in these other element documents.
Since some users may not always complete these other element documents during the
same session that the Element 7 document is produced, these extra tables are generated at
the end of the document file for Element 7. The disadvantage is that you must then copy
and paste them into their respective element documents (where there are notes to remind
you where the appropriate tables go). However, the advantage is that you do not have to
answer the same questions over and over again for each of the other elements in order to
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have the SWAMP Advisor automatically find the appropriate data and generate the tables
that you need.

3.2 SWAMP Advisor Navigation

The SWAMP Advisor is a menu-driven program and throughout it you will be able to
navigate among various elements using menu selections. There are two types of buttons:

1 When a question is asked with a round “radio button” next to the possible
selections (for example, like the bullet used with this paragraph), then you may
select only one of the available choices.

When a question is asked with square “check boxes” next to the possible
selections (for example, like the illustration used with this paragraph) then you
may select more than one choice (even all of them if you wish).

Note also that there are three “navigation bars” in each and every left_side frame. These
will appear in all screens of the expert system in the left frame.

1 The “OK” button will advance you to the next question or answer.
2 The “Back” button will return you to the previous screen.
3 The “Restart” button will exit the current use of the program and restart it.

Once you make a menu selection you proceed forward, answering questions with buttons
and receiving advice and information from the expert system (left side frame) and the
associated Explanation Screens (those in the right side frame). You may also go back and
change your selections using the “Back” button at any time.

3.3 Color Coded Title Bars

As you progress through various elements and sub-elements you realize that developing a
QAPP is a complex process with many different levels. In order to help users keep
perspective of where they are in the process, Color Coded Title Bars have been added to
each question asked. These are illustrated in Figure 3.2.
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Group A Elements: Project Management

Element 6 - Project/'Task Description
Section 6.1 - Work Statement and Produced Products

6.1.3.1 - Please list any other reports that will be generated by your project.

Figure 3.2 - lllustration of Title Bars in the Left Frame Questions.

The top title bar shows the “Group” in which you are working. Groups A, B, C, and D
each have “Top Level” title bars.

Each “Element” has a color coded title bar — these are the second level bars directly under
the top level title bar.

When there are “Sub-elements” (for example, Element 6.1, 6.2, 6.3, etc.) these appear as
third level bars directly under the relevant second level “Element” title bar. Furthermore,
although different background colors are used to highlight differences between the third
and second level bars, the same text color is used in the third level bar and its associated
second level Element Title to emphasize their relationships to each other.

3.4 Multiple Planes of Information

The SWAMP Advisor is developed using the concept of multiple planes of information.
These are illustrated in Figure 3.3.
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Figure 3.3 - Three Planes of Information in the SWAMP Advisor

At the highest level (“Executive Plane”) you can cruse through the questions and receive
rapid short answers and advice.

More information is provided at the second level (the “Educational Plane”) which is
always located in the “Explanation Screen” in the right frame. Educational information
usually focuses on the “What, Where, When, Why, and How” aspects of a given question
or answer.

A third level, reached from links through either the left or right frame is called the
“Research Plane” and it typically contains reports, documents (for example, table formats
or slides) and links to other Internet sites (for example, EPA or California web sites).

“Pop-up” definitions and comments are also provided for selected acronyms and
technical words used in the Explanation Screen. These are always formatted using red
underlined type to distinguish them from the usual links (formatted in blue underlined
type) to other information, documents, or web sites. These designations are emphasized
in the very first Explanation Screen that appears when the SWAMP Advisor is booted up.

4.0 Preparing Your Final QAPP

The SWAMP Advisor has a cover page file named “CoverPage.doc” that you may
download from either the opening page right side screen or one of the final screens in
Element 24. If you have prepared, saved, and correctly named each of the document files
from all of the elements in the SWAMP Advisor then this file will automatically append
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all of them in the correct order for a Master QAPP document.

4.1 Numbering QAPP Files

The SWAMP Advisor sends document files to your computer’s browser in “Rich Text
Format” (RTF). In order to easily manage the text of each file they should be named in an
easily remembered and consistent format. And, since the macro in the “CoverPage.doc”
file searches for and appends files in the correct sequence, they must be named correctly.
Each file is named using the Element number followed by “-QAPP.rtf” for consistency.

For example, the filename for Element 3 is, “3-QAPP.rtf” and that for Element 4
is, “4-QAPP.rtf”.

Table 4.1 - Correct Naming Format for All Element QAPP Files

1-QAPP.rtf 9-QAPP.Itf 18-QAPP.rtf
3-QAPP.itf 10-QAPP.tf 19-QAPP..rtf
4-QAPP.rtf 11-QAPP..ritf 20-QAPP.rtf
5-QAPP.rtf 12-QAPP..rtf 21-QAPP.rtf
6-QAPP.rtf 13-QAPP.rtf 22-QAPP.rtf
7-QAPP.rtf 14-QAPP.rtf 23-QAPP.rtf
8-QAPP.Itf 151617-QAPP.rtf 24-QAPP.rtf

There are only two exceptions as shown above in Table 4.1:

1. There is no file for Element 2, Table of Contents. The heading “2.0 Table of Contents”
is at the bottom of the Element 1 document file because there are no questions associated
with the Table of Contents — it is simply an automatic procedure.

2. The SWAMP Advisor combines questions involving Elements 15, 16, and 17 into one
menu selection (see Section 3.1) because of the interrelated nature of the questions and
the information being gathered. Therefore, this file is named, “151617-QAPP.rtf.

4.2 Previewing Draft Text

As you go through each element, those in which the SWAMP Advisor develops key text
from your input will automatically be presented to you with a preview of the draft
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product. In some cases this will be shown to you at the end of your work with an element
and in other cases, where elements are more complex and contain sub-elements, a
preview of the sub-element you just finished will be shown to you. An example of this
latter situation is with a preview of your answers with the Bioassay Section questions of
Element 6, Section 1.

In previewing the draft text please note that this format is not as flexible as the text
formats in the QAPP document files. Therefore, you may sometimes note extra text
headings that is not relevant to your answers — this will not appear in your QAPP
document files. In the future the preview format may be changed to reflect the “What you
see is what you get” concept but, for now, the current preview format is less expensive.

After reviewing the draft text if you want to change any of your answers then simply use
the “back” button to go back to the question where the change is to be made, change
your answer and then go back to the end again.

Going back to the end of a section again can be quite fast because all you have to
do is click on the “OK” button — if you didn’t change anything then you’ll see that
your previous answer is still present in the system and you simply go on back to
the end.

Again your draft text will be presented for review and you should note the change in it

that your revision(s) to the question(s) resulted in.

4.3 Saving Draft Text for Printing and Appending to the QAPP

After you have reviewed and accepted the draft text, as explained above, you will be
asked if you wish to save it in a Rich Text Format (RTF). If you select “No.” then you
will simply go on to the next question.

If you select “Yes” then the QAPP document file will be sent to your browser for review
and/or saving. This file will open in a new window in your browser.

You MUST rename this file and save it to your computer. You may save it to a hard
drive or a floppy diskette, or even a read-write CD-ROM - it is your choice.

HINT: itis best to start a new folder with the name of your QAPP or project

prior to saving any files. If you save your files to a floppy diskette then this

probably isn’t necessary, assuming that you have no other files on the diskette.
Because you will be appending each saved file to your Master QAPP in numerical order
by Element Number and using a macro, you must name each file correctly. The correct
format for file names is provided in Section 4.1 and all file names are listed in Table 1.

Follow the directions below:
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1. Click on “File” in the Toolbar of the RTF document.
2. Choose the “Save As” option.

3. At the bottom of the “Save As” dialog box is a selection identified as “Save As
Type” with a drop down menu of choices. Select the choice “Rich Text Format
(*.rtf)” by clicking on that selection.

4. Type in the new file name using the Element Number and “-QAPP.” You also
include the path in the name if it is not already present and correct.

For example, if you are saving to a floppy diskette (typically Drive A)
then the path for Element 6, Section 4 would typically be:

A:/6-QAPP.rtf

If you were saving it to a folder named MyProjectQAPP on your hard
drive C:, then the path and name would be:

C:/MyProjectQAPP/6-QAPP.rtf

4.4 Reformatting Tables in Saved Text Files

All tables in Rich Text Format files are in a “comma-delimited” format. An example is
shown below:

Analyte, Method Type/Principle, Detection Limit, Precision
Arsenic, Flame Atomic Absorption, 100 ug/L, 20%
Cadmium, ICP-Atomic Emission, 1 ug/L, 10%

Lead, Graphite Furnace Atomic Absorption, 60 ug/L, 15%

To convert a comma-delimited format to a regular table format follow these instructions:

Highlight the comma-delimited data (including column headings)
On the toolbar menu click on “Table”

In the Table Menu click on “Convert”

In the Convert options click on “Text to Table”

The instant result shown as Table 2 below:

SAEIE R
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Table 4.2 - Example of a Text to Table Conversion

Method IDetection Limit [Precision
Type/Principle

Llilame Atomic [100 ug/L 20%

Analyte

Arsenic
bsorption

[Cadmium “ICP-Atomic 1 ug/L 10%

Emission
Eraphite 160 ug/L 15%

|Lead
Furnace Atomic
bsorption

Using MS Word you may then convert the basic table to whatever format headings and
body that you prefer.

4.5 Appending Files to Build a Master QAPP

A “Master QAPP” will automatically be constructed for you from a “macro” that has
been imbedded in the file named “CoverPage.doc” that is downloaded from the SWAMP
Advisor web site. The link to download the CoverPage.doc file is in the right side frame
of the opening screen of the SWAMP Advisor and also in the right side frame of one of
the last questions in Element 24. When you click on this link you should save this file to
the same folder in which all of your document files from each element were saved.

Follow the instructions below:
= Your QAPP folder will contain 21 files all ending in “-QAPP.rtf”

= After all files are present then you download the Cover Page.

1. Download link is in the right side panel of the SWAMP Advisor opening page
and also in the last right side panel of the last “element” (Element 24).

1. Save the cover page to your QAPP folder. It has a macro that will
automatically find and append each of the 21 files in the correct order and
then to automatically prepare the table of contents.

1. Go to the bottom of the page and press the “Alt” and letter “a” keys (Alt + A)

to activate the macro.
2. Complete all final edits and formatting (including changing comma-delimited
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tables into regular table format), rename and save the file, and print it.

If there are any problems then refer to Sections 1.5 or 1.6 for solutions to all known
problems that could happen.

4.6 Building a Table of Contents

When the macro described in Section 3.5 has competed building your Master QAPP
document then it automatically also builds your Table of Contents in Section 2.0.
Therefore, you should not have to do anything to prepare your Table of Contents.

However, if you need to modify sections of your QAPP (for example, adding or deleting
sections) then follow the instructions below to manually build a Table of Contents.

1. Move your cursor to a blank line below “Section 2.0 — Table of Contents.”
2. Click on “Insert” from the toolbar.

3. Select “Reference” from the drop down menu.

4. In the selection box from “Reference” select “Index and Tables.”

5. Next, select “Table of Contents” from the menu tab and review the options available
to you. Select those that are applicable and that you wish to use. The headings used for
the element files include Headings 1, 2 and 3 plus Heading 4 for Table Names.

6. As soon as you click on the “Okay” button a new Table of Contents will instantly and
automatically be generated below your cursor.

5.0 Instructions for Preparing Element Documents

The SWAMP Advisor is an expert knowledge system that uses “decision trees” to
provide appropriate answers and advice for your QAPP document files. There are many
different technical approaches to any given project. For example, one project may require
field analyses involving temperature, specific conductivity and selected nutrient analytes
for water quality monitoring while another may require laboratory analyses of PCBs, lead
and arsenic. Perhaps a third project may require both field and laboratory analyses.
Therefore, in these examples, the three QAPPSs being prepared would each need different
information in the elements that describe problem definition (Element 5), project / task
description (Element 6), quality objectives and criteria for measurement data (Element 7),
sample processing design (Element 10), sampling methods (Element 11), sample
handling and custody (Element 12), analytical methods (Element 13), and quality control
(Element 14) among others. Figure 5.1 illustrates this concept.
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How an Expert Knowledge System Works

User Follows a Decision Tree Path to the Correct Answer

Yes -« o T

No
Q2A / A Decision \‘ Q2B
| Tree
A2 answers B2 answers ‘
T | | [ T

Q3 A Q3B

A3 answers \ B3 answers
Yes No
’7

Surfoce Woter

Result: Get to right answer rapidly & skip all extraneous information. nees vesiorisg

Figure 5.1. Conceptual Diagram of a Decision Tree

Obviously, it is not feasible to discuss all possible branches of every decision tree
because there would be thousands of possibilities. Therefore, in the illustrations used for
the instructions provided with each element below, what could be a “typical” scenario is
arbitrarily selected. You may choose to follow a different path for your needs but the
choices selected for illustrating the use of each element’s decision tree path will cover the
basic concepts that you will encounter.

5.1 Element 1 — Title and Approval Page Information

5.1.1 - Content Checklist for Element 1

In order to complete the Title Page, you will need the following information:

The title of your project,

Your proposal number,

The date of your QAPP,

The name of the organization responsible for drafting and executing the plan,
The name of the applicant organization’s project manager,

The name of the applicant organization’s quality assurance officer,

The names of any other people in the applicant organization’s signature table,
The name of the California State Water Control Board’s contract manager,
The name of the California State Water Control Board’s quality assurance officer,
and

e The names of any other people in grant organizations signature table.
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5.1.2 - Instructions for Element 1

Remember, you can not use any commas when entering information that will be used to
build a comma-delimited table in this element.

The first question (1.1a) asks you to enter the name of your project. Type your project
name in the space provided in the left side screen and click on the “OK” button.

Note: A concise title can convey a great deal of information about the scope and intent of
your project with just a few words. It can also help guide people looking for similar
information towards your work.

Question 1.1b asks you to enter the proposal number for your project. This may be
assigned by the funding organization or by your organization but it is a unique number
used to track proposal submissions. Enter the number in the space provided in the left
side screen and click on the “OK” button.

Question 1.1c asks you to enter the date of this QAPP. You may enter today’s date or a
date in the future in which you plan to submit the QAPP. This date can easily be edited, if
needed, on the date that you actually do submit the QAPP. Enter the date in the space
provided in the left side screen and click on the “OK” button.

Question 1.1d asks you to enter your organization’s name. Enter the name in the space
provided in the left side screen and click on the “OK” button.

Question 1.2a asks you to enter the name of the project manager. Enter the name in the
space provided in the left side screen and click on the “OK” button.

Question 1.2b asks you to enter the name of the quality assurance officer. Enter the name
in the space provided in the left side screen and click on the “OK” button.

The project manager and quality assurance officer questions provide the minimum
required information required for a signature table from the applicant
organization. However, you may wish to add additional people to this signature
table. If so, then select “Yes” to the additional signature question 1.2c and you
will be asked to enter the next person’s name and title in the spaces provided.
Additionally, you may opt to add a fourth person’s name and title to the
organization’s signature table by repeating the same process. However, we will
stop with question 1.2b (entering the name of the quality assurance officer).

Having selected “No” to the addition of more people to the signature table in question
1.2c, the next question (1.2d) asks you to enter the name of the funding agency’s contract
manager. This will be a person from the California State Water Resources Board. Enter
the name in the space provided in the left side screen and click on the “OK” button.

Question 1.2e asks you to enter the name of the funding agency’s quality assurance
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officer. This will be a person from the California State Water Resources Board. Enter the
name in the space provided in the left side screen and click on the “OK” button.

The contract manager and quality assurance officer questions provide the
minimum required information required for a signature table from the California
State Water Resources Board. However, you may wish to add additional people to
this signature table. If so, then select “Yes” to the additional signature question
1.2f and you will be asked to enter the next person’s name and title in the spaces
provided. Additionally, you may opt to add a fourth person’s name and title to the
California State Water Resources Board’s signature table by repeating the same
process. However, we will stop with question 1.2e (entering the name of the
quality assurance officer).

Once you have selected “No” to the choice in question 2e (or alternatively, have
continued to add one or two other people to the signature table) then a draft of your
answers will immediately be presented in the left side panel for your review. If you did
not select any optional additional people to add to the tables then you will note a series of
commas in the lines following the signature names and titles. Ignore these commas
because they represent “holding spaces” for a comma-delimited table that could include
more people; your Element 1 QAPP text document will not show these extra commas. In
the future, if desired, a more advanced display of answers that exactly mimics the actual
text documents produced could replace the current display.

Click on the “OK” button when you are finished reviewing the displayed draft
information.

The next question asks if you want to save the draft text that you just reviewed to a “Rich
Text Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you
click the “OK” button the SWAMP Advisor will compile your answers into a correctly
formatted document for Element 1 and send it to your browser. If you do not see this
happen then check Section 1.1 for solutions to the problem. Possible problems include
your browser not having the tool bar options tab checked to download documents, a pop-
up blocker not being deactivated, a security system such as in Internet Explorer’s Version
7 blocking the file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, *1-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then page down to where you see the instructions:

G Begin Highlighting Table for Formatting Below This Line ------------ >
and
S End Highlighting Table for Formatting Above This Line --------------- >
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for the Organization’s Signature Table.

Highlight the text between the two instructions as indicated.
Hint: if you highlight from the bottom right of the text area to the top left of the
text area then you will avoid including an extra space at the bottom right in your
highlighted area. If you do have an extra space in the bottom right highlighted
area then it may sometimes cause an extra empty row to appear in your formatted
table.

After highlighting the text that will be in the table, then click on “Table” in your MS
Word toolbar.

Next, select “Convert” from the drop down menu.

Next select “Text to Table” from the sub-menu.

If you highlighted the table text correctly then you will see a correctly completed
“Convert Text to Table” box in which the bottom row information has “Separate text at”

with the “Commas” button selected.

Click on the “OK” button and the comma-delimited text will instantly be converted to a
“regular” table format.

Repeat this process for the second table for California State Water Resource Board.

After the two tables have been formatted to regular table format then delete the arrows
with instructions above and below each table.

This completes the work with Element 1.
Note that heading “2.0 — Table of Contents’ is located at the bottom of this page. It is a
placeholder for the Table of Contents which is automatically prepared from a “macro” in

the “CoverPage.doc” file and nothing needs to be done with it.

5.2 Element 2 — Table of Content Information

5.2.1 - Content Checklist for Element 2

In order to complete the Table of Contents, you will need the following information:

e All 21 element document files correctly named and saved in the folder where the file
named “CoverPage.doc” is located.
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e The downloaded and saved file named “CoverPage.doc” in the same folder where all
21 completed and correctly named document files have been saved.

5.2.2 - Instructions for Element 2

The Table of Contents for Element 2 will automatically be completed from a “macro”
that is embedded in the file named “CoverPage.doc”

After CoverPage.doc has been downloaded from the folder where all 21 correctly named
QAPP documents have been saved then open it and place your cursor at the bottom of the
page where the instructions on that page indicate.

With your cursor in place at the bottom of the page, simultaneously press the “Alt” and
the letter “a” keys (Alt + a ). This action will activate the macro which, in turn, will
automatically add each of the 21 QAPP document files in the correct order. Next, the
macro will automatically prepare the Table of Contents under the “2.0 Table of Contents”
heading.

Once the Table of Contents has finished its work then save the file and, if you wish,
rename the file.

5.3 Element 3 — Distribution List Information

5.3.1 - Content Checklist for Element 3

In order to complete this list, you will need the following information:

e The name, title, organization, and telephone number of each QAPP recipient.

e The above information for the following people: Contractor Program Manager,
Contractor Quality Assurance Officer, the California State Water Resources
Board Contract Manager, and the California State Water Resources Board Quality
Assurance Officer. Note that these four people’s information is also required in
Element 1.

The following list is not mandatory; it is a list of potential people who also may logically
be included in your distribution list if you wish.

Laboratory / Field Team Director
Laboratory / Field Team QA Officer
Data Processors / Reviewers
Statisticians / Modelers

Contractors / Subcontractors
Regulators
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5.3.2 - Instructions for Element 3

The first screen of this element provides background information. You may click on the
links in the right side screen to see an example of a distribution table and to get advice on
the content of this table. Click the “OK” button to proceed to the first question.
Remember, you can not use any commas when entering information that will be used to
build a comma-delimited table in this element.

The contractor’s program manager name is the first required information. Enter that
person’s name in the space provided in the left side screen Number 3.1 and click on the
“OK” button.

The next questions ask for the telephone number and a unique QAPP copy number for
the program manager. Enter each of these pieces of information in the space provided in
the left side screen and click on the “OK” button. A unigue copy number is assigned to
each QAPP that is distributed so that they can be tracked.

The contractor’s quality assurance officer is the second required information. . Enter that
person’s name in the space provided in the left side screen Number 3.2 and click on the
“OK” button.

The next questions ask for the telephone number and a unique QAPP copy number for
the quality assurance officer. Enter each of these pieces of information in the space
provided in the left side screen and click on the “OK” button.

The California State Water Resources Board contract manager is the third required
information. . Enter that person’s name in the space provided in the left side screen
Number 3.3 and click on the “OK” button.

The next questions ask for the telephone number and a unique QAPP copy number for
the contract manager. Enter each of these pieces of information in the space provided in
the left side screen and click on the “OK” button.

The California State Water Resources Board quality assurance officer is the fourth
required information. . Enter that person’s name in the space provided in the left side
screen Number 3.4 and click on the “OK” button.

The next questions ask for the telephone number and a unique QAPP copy number for
the Board’s quality assurance officer. Enter each of these pieces of information in the
space provided in the left side screen and click on the “OK” button.

The next question asks if there are additional people that you want to add to your

distribution list table. If there are others then select “Yes” and you will be asked to enter
their title, name, phone number, and a unique QAPP copy number respectively. You may
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also go through the procedure again to add a second (and last) optional person to the
distribution list for a total of 4 required names and 2 optional names. The sixth person is
the last who can be added using the SWAMP Advisor to build this particular table. If
additional people are desired then it is easier to simply add rows to the existing table and
enter the information for them.

Once you have finished adding information to your table then a draft of your answers will
immediately be presented in the left side panel for your review. If you did not select any
optional additional people to add to the tables then you will note a series of commas in
the lines at the bottom of the comma-delimited table. Ignore these commas because they
represent “holding spaces” for a comma-delimited table that could include more people;
your QAPP text document will not show these extra commas. In the future, if desired, a
more advanced display of answers that exactly mimics the actual text documents
produced could replace the current display.

Click on the “OK” button when you are finished reviewing the displayed draft
information.

When you have completed reviewing the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 3 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “3-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then page down to where you see the instructions:

Sommmmmmmmmmeee Begin Highlighting Table for Formatting Below This Line ------------ >
and
S End Highlighting Table for Formatting Above This Line --------------- >

for the Distribution Table.
Highlight the text between the two instructions as indicated.

Hint: if you highlight from the bottom right of the text area to the top left of the
text area then you will avoid including an extra space at the bottom right in your
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highlighted area. If you do have an extra space in the bottom right highlighted
area then it may sometimes cause an extra empty row to appear in your formatted
table.

After highlighting the text that will be in the table, then click on “Table” in your MS
Word toolbar.

Next, select “Convert” from the drop down menu.
Next select “Text to Table” from the sub-menu.

If you highlighted the table text correctly then you will see a correctly completed
“Convert Text to Table” box in which the bottom row information has “Separate text at”
with the “Commas” button selected.

Click on the “OK” button and the comma-delimited text will instantly be converted to a
“regular” table format.

After the table has been formatted to regular table format then delete the arrows with
instructions above and below each table.

This completes the work with Element 3.

5.4 Element 4 — Project / Task Organization List Information

5.4.1 - Content Checklist for Element 4

In order to complete this list, you will need the following information:

e The name, organization affiliation, title and contact information (e.g., phone
number, fax number and e-mail address) for each person that has a lead role in the
project.

The following list is not mandatory; it is a list of potential people who also may logically
be included in your project / organization list if you wish.

State or Regional Board Project Manager

State or Regional Board Quality Assurance (QA) Program Manager
State Grant Applicant Manager

Grant Applicant's QA Program Manager

Grant Applicant's Laboratory Director

Grant Applicant's Laboratory/Field QA Officer

Grant Applicant's Field Activities Director

Grant Applicant's Data Management Director
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e Grant Applicant's Sub-contractors

5.4.2 - Instructions for Element 4

The first screen of this element provides background information. You may click on the
links in the right side screen to see an example of a project organization table and to get
advice on the content of this table. Click the “OK” button to proceed to the first question.

The first question asks you to briefly describe the proposed organization for your project.
You may already have this information in your Monitoring Plan and, if so, just copy and
paste it. Otherwise, provide the requested information in paragraph form. An example
from the Sycamore Creek Monitoring Plan shows the kind of information that should be
included (this is not an actual plan but, rather, an example prepared by SWAMP staff).

Question 4.1.1 asks for the name of the first person you want in your table. Enter the
information in the space provided in the left side screen and click on the “OK” button.
Remember, you can not use any commas when entering information that will be used to
build a comma-delimited table in this element.

Question 4.1.2 asks for the organizational affiliation of the first person. Enter the
information in the space provided in the left side screen and click on the “OK” button.

Question Number 4.1.3 asks for the title of the first person. Enter the information in the
space provided in the left side screen and click on the “OK” button.

Question 4.1.4 asks for contact information for the first person. . Enter the information in
the space provided in the left side screen and click on the “OK” button.

Repeat this process to add information for two additional people. After information for
the first three people have been added the next question (4.4) asks if you want to add
information for an additional person. If you do, then repeat the process above
(remembering not to use any commas).

After information for the fourth person has been added the next question (4.5) asks if you
want to add information for an additional person. If you do, then repeat the process
above, otherwise select “No” and click on the “OK” key. This is the last person’s
information that can be added using the SWAMP Advisor to build this particular table. If
additional people are desired then it is easier to simply add rows to the existing table and
enter the information for them.

Question 4.3.5 asks you to describe the duties of the key personnel that you have
included in your table. You may copy this information from your Monitoring Plan if it is
available or else provide it in paragraph form. A brief example that shows the kind of
information that should be included appears in the right side screen. You may copy and
modify this to fit your project needs if you wish, remembering that duties of the key
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personnel in your table should be described.

Section 4.2 of this QAPP document requires a description of the quality assurance
officer’s role. Please enter that information in the space provided in the left side screen of
question 4.2 and click on the “OK” button. A brief example that shows the kind of
information that should be included appears in the right side screen. You may copy and
modify this to fit your project needs if you wish.

Section 4.3 of this QAPP document requires a description of the person or persons
responsible for updating the QAPP. Please enter that information in the space provided in
the left side screen of question 4.3 and click on the “OK” button. A brief example that
shows the kind of information that should be included appears in the right side screen.
You may copy and modify this to fit your project needs if you wish.

Once you have finished adding information to Section 4.3 then a draft of your answers
will immediately be presented in the left side panel for your review. If you did not select
any optional additional people to add to the tables then you will note a series of commas
in the lines at the bottom of the comma-delimited table. Ignore these commas because
they represent “holding spaces” for a comma-delimited table that could include more
people; your QAPP text document will not show these extra commas. In the future, if
desired, a more advanced display of answers that exactly mimics the actual text
documents produced could replace the current display.

Click on the “OK” button when you are finished reviewing the displayed draft
information.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 4 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “4-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then page down to where you see the instructions:
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for the Distribution Table.

Highlight the text between the two instructions as indicated.
Hint: if you highlight from the bottom right of the text area to the top left of the
text area then you will avoid including an extra space at the bottom right in your
highlighted area. If you do have an extra space in the bottom right highlighted
area then it may sometimes cause an extra empty row to appear in your formatted
table.

After highlighting the text that will be in the table, then click on “Table” in your MS
Word toolbar.

Next, select “Convert” from the drop down menu.

Next select “Text to Table” from the sub-menu.

If you highlighted the table text correctly then you will see a correctly completed
“Convert Text to Table” box in which the bottom row information has “Separate text at”

with the “Commas” button selected.

Click on the “OK” button and the comma-delimited text will instantly be converted to a
“regular” table format.

After the table has been formatted to regular table format then delete the arrows with
instructions above and below each table.

This completes the work with Element 4.

5.5 Element 5 — Problem Definition / Background Information

5.5.1 - Content Checklist for Element 5

In order to complete this section, you will need the following information:

e The problem statement in paragraph format; i.e., a summary of each problem being
addressed by the project.

e The expected outcomes from your project; i.e., a summary of how the project
information would be used.

e A brief statement of any regulatory or water quality criteria that your project
addresses.
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5.5.2 - Instructions for Element 5

The first screen of this element (5.0) provides background information on what
information a reviewer may typically expect to find in this element’s document based on
what the objectives of the project are. Useful examples and advice are provided from
links in the right side screen. After you have finished reading the information provided,
then click on the “OK” button to proceed to the first question.

Question 5.1 asks for a description of the problem that you are addressing. You should
include a summary of the problem(s) that will be examined by your project, an
explanation of how your project will address the identified problem(s), and a brief
description of the project's study area. The right side screen provides useful information
and an example passage that you may copy and paste, with appropriate edits to fit your
needs, if you wish. Enter the information in the space provided in the left side screen and
click on the “OK” button.

Question 5.2 asks for a brief statement of the expected decisions or outcomes of your
project. You would typically include the decision(s) or outcome(s) expected of your
project, the specific information or data that will be produced by your project, and the
expected use(s) of project information. The right side screen provides useful information
and an example passage that you may copy and paste, with appropriate edits to fit your
needs, if you wish. Enter the information in the space provided in the left side screen and
click on the “OK” button.

Question 5.3 asks for a brief statement of any water quality or regulatory criteria that
relate to your project. You would typically include water quality or regulatory criteria
associated with the project and any future limits or regulations that may result from the
project. If there are none then state that fact. The right side screen provides useful
information and an example passage that you may copy and paste, with appropriate edits
to fit your needs, if you wish. Enter the information in the space provided in the left side
screen and click on the “OK” button.

Once you have finished adding information to Section 5.3 then a draft of your answers
will immediately be presented in the left side panel for your review. Click on the “OK”
button when you are finished reviewing the displayed draft information.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 5 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.
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Click on the “File” tab in the MS Word file, select “Save As” and name this file, “5-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 5.

5.6 Element 6 — Project / Task Description

5.6.1 - Content Checklist for Element 6

In order to complete this section, you will need the following information:

A list of report types that you plan to generate with the project.

A list of the types of sampling stations that will be employed.

A brief description of the sampling area and how frequently you plan to sample it.
A list of the “media” you will be sampling.

A list of the sampling techniques you plan to use for water samples.

5.6.2 - Instructions for Element 6

The first question (6.1.1) asks whether you plan to generate new laboratory and/or field
data or not. In most cases the answer will be “Yes.” Depending on your answer you will
go down two very different branches of related questions. We are going to assume that
you have answered “Yes” and clicked on the “OK” button.

Question 6.1.2 provides background information about various typical reports that are
associated with environmental monitoring projects. When you have finished reading this
information then select the “Continue” button and click on the “OK” button.

Question 6.1.3 lists numerous standard report types. You should check all that apply and
then click on the “OK” button to continue to the next screen. This information will then
automatically be included in the text document for this element.

Question 6.1.3.1 provides space for you to describe any additional (customized) reports.
Useful advice and information are provided in the right side screen. If no additional
reports are planned then state that and click on the “OK” button to continue.

Question 6.1.4.1 provides a list of common sampling station types used with SWAMP
projects and you may select all that apply. If there is another type of sampling station that
is not listed, and that your project will use, then check the “Other” box and you will be
able to describe it in Number 6.1.4.1 — Other. After you are finished with these questions
click the “OK” button to continue to the next question.

Question 6.1.4.2 asks you to list the frequency of your sampling. This may be daily,
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weekly, once every few months, etc. Note that your answer should not be a complete
sentence but rather the end of a sentence that begins with “Samples will be collected
........... ” Enter the information in the space provided in the left side screen and click on
the “OK” button.

Question 6.1.5 asks you to briefly identify the sampling area. Enter the information and
click on the "OK" button.

Question 6.1.7 asks whether you will be conducting measurements in the field, in a
laboratory, or both. Select one of the three possibilities and click on the “OK” button. The
most complex example assumes that you will conduct both field and laboratory
measurements and that is the scenario that we will describe in the next screens.

Question 6.1.6.0 asks you to identify the media that will be sampled. U.S. EPA classifies
samples into main categories called "media.” These include water, sediments and soils,
and tissues from organisms. However, these categories may not be sufficient for your
plans so if you plan to sample an additional category (for example, waste containers) then
select "Other" as a choice. SWAMP currently has bioassessment protocols for wadeable
streams and that is what will be considered if you "select tissues / organisms." For other
situations please select "Other" as a choice. Click the “OK” button after you have made
your selections. If you selected “Other” then you will be able to describe your sampling
medium; otherwise you will not be asked to do that.

The first medium considered is water samples and question 6.1.6.1 provides a list of four
commonly used techniques plus the ability to select “Other” and describe a different
sampling technique if you wish. Descriptions and examples of the four basic techniques
are available from a link in the right side screen. Select all techniques that apply to your
project plans and click the “OK” button to continue.

Turning to the next medium — sediment — question 6.1.6.2.1 asks you to describe the
sediment and how the samples will be used. Some example text that you may copy and
edit to meet your plans, if you wish, appears in the right side screen.

The third medium — tissues — can involve various animal organs and/or new bioassay
questions. Select all that apply and click on the “OK” button to continue; we will select
both for this discussion.

Question 6.1.6.3.0A asks for a description of the organisms that you plan to collect and
how they will be used. A useful example in the right side screen may be copied and
pasted, after appropriate edits for your plans, in the space provided in the left side screen.
Click on the “OK” button to continue.

Question 6.1.6.3.1.is the beginning of a series of questions describing your bioassay plans
so that the results will be SWAMP-comparable. All SWAMP-funded bioassessments are
required to follow guidance specified in the February 2007 Benthenic Sampling Standard
Operating Procedures. This includes collecting samples using two methods (i.e.,
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targeted-riffle composite and reachwide benthos composite) under most conditions with
only two exceptions. For the purposes of this question — and the following bioassay
guestions — we are going to assume that you will meet all SWAMP-comparable
requirements. Therefore, select “Yes” and click on the “OK” button to continue.

Question 6.1.6.3.1A asks for a brief description of your plans for macroinvertebrate
collection. A useful example in the right side screen may be copied and pasted, after
appropriate edits for your plans, in the space provided in the left side screen. Click on the
“OK” button to continue.

Question 6.1.6.3.2 asks if you plan to include at least 10% replication on all
macroinvertebrate samples because this is a requirement for SWAMP-comparable data.
Select “Yes” and click on the “OK” key to continue.

Question 6.1.6.3.2A asks for a brief description of your plans. A useful example in the
right side screen may be copied and pasted, after appropriate edits for your plans, in the
space provided in the left side screen. Click on the “OK” button to continue.

Question 6.1.6.3.3 asks if you plan to use the Southwest Association of Freshwater
Invertebrate Taxonomists (SAFIT) and utilize the SAFIT Level Il taxonomic effort (STE)
because this is a requirement for SWAMP-comparable data. Select “Yes” and click on
the “OK” key to continue.

Question 6.1.6.3.3A asks for a brief description of your plans. A useful example in the
right side screen may be copied and pasted, after appropriate edits for your plans, in the
space provided in the left side screen. Click on the “OK” button to continue.

Question 6.1.6.3.4 asks if you plan to include a minimum of 10% reidentification of
samples using an external quality assurance laboratory because this is a requirement for
SWAMP-comparable data. Select “Yes” and click on the “OK” key to continue.

Question 6.1.6.3.4A asks whether or not the external quality assurance laboratory has
been approved by the SWAMP Quality Assurance Officer because this is a requirement
for SWAMP-comparable data. Select “Yes” and click on the “OK” key to continue.

Question 6.1.6.3.4B asks for a brief description of the approval that you have received
from the SWAMP Quality Assurance Officer. A useful example in the right side screen
may be copied and pasted, after appropriate edits for your plans, in the space provided in
the left side screen. Click on the “OK” button to continue.

Question 6.1.6.3.5 asks you to select which California latitude best describes where you
plan to sample and you may select the one that best describes your plans. This will enter a
statement as to which index period you plan to use in your text document. All SWAMP-
funded bioassessments are required to include sampling during the most appropriate
index period (i.e., time of year that samples are collected). This is to ensure data
comparability by requiring that samples are collected during standardized index periods.
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Since the appropriate index period varies at different latitudes and elevations, the best
times to sample will vary by geographic locations within the state. Select the most
appropriate answer and click on the “OK” button to continue.

Question 6.1.6.3.5A through 6.1.6.3.5D depends on which geographic location you
selected — you will only be asked one of these questions. You are asked to enter a brief
description of the appropriate sampling time period. A useful example in the right side
screen may be copied and pasted, after appropriate edits for your plans, in the space
provided in the left side screen. Click on the “OK” button to continue.

Question 6.1.6.3.6 asks if you plan to follow SWAMP-comparable guidance and use a
minimum organism fixed-count per sample of 600. Select “Yes” and click on the “OK”
button to continue.

Question 6.1.6.3.6A asks if you plan to use the grid-tray method. Select “Yes” and click
on the “OK” button to continue.

Question 6.1.6.3.6B asks for a description of your use of the grid-tray method. A useful
example in the right side screen may be copied and pasted, after appropriate edits for
your plans, in the space provided in the left side screen. Click on the “OK” button to
continue.

Question 6.1.6.3.7 asks if you plan to include the full suite of physical habitat methods as
recommended by SWAMP. Select “Yes” and click on the “OK” button to continue.

Question 6.1.6.3.7A asks for a description of your use of the full suite of physical habitat
methods. A useful example in the right side screen may be copied and pasted, after
appropriate edits for your plans, in the space provided in the left side screen. Click on the
“OK” button to continue.

Question 6.1.6.3.8 asks if you would like a preview of your answers to the bioassessment
segment of Element 6 text. This is because this segment was so long and involved that
you may wish to see a preview so that you can go back and change any that you need to.
You will see all of this information again in the full Element 6 preview. Select “Yes” and
click on the “OK” button to continue.

After previewing your answers click on the “OK” button to continue if you are satisfied
with them.

Question 6.1.8 asks you to select the type of weather conditions under which sampling
will occur. Select the appropriate answer and a statement to that effect will automatically
be entered into your document text. Click on the “OK” button to continue.

Question 6.2 asks you to select which of three major analyte groups will be used during

your project. Select all three and click on the “OK” button to continue. Each group will
be addressed in sequence.
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Question 6.2.1 asks you to describe the field testing parameters that you plan to conduct.
Typical examples include dissolved oxygen, specific conductivity, pH, temperature,
turbidity, salinity, depth, flow velocity, etc. Enter the requested information and click on
the “OK” button.

Question 6.2.1.1.asks you to select any of the ELISA kit types that you plan to use. You
may select all that apply and then click on the “OK” button to continue.

Question 6.2.1.2 asks you to describe the field test kits that you plan to use. A useful
example in the right side screen may be copied and pasted, after appropriate edits for
your plans, in the space provided in the left side screen. Click on the “OK” button to
continue.

Question 6.2.1.3 asks you to select all of the laboratory analytical groups that you plan to
monitor. Each group that you select will lead to a new question where you may list
the specific analytes that you plan to analyze for. For this exercise select Conventional
Analytes in Water (QMP Table Ala) and Synthetic Compounds in Water (QMP Table
A10) and click on the “OK” button to continue.

As a result of your selection of Conventional Analytes in Water question Number
6.2.1.3.B.1a is asked and you may enter any from the list of analytes that are in the right
side screen and then click on the “OK” button to continue..

As a result of your selection of Synthetic Compounds in Water question Number
6.2.1.3.B.10 is asked and you may enter any from the list of analytes that are in the right
side screen and then click on the “OK” button to continue..

Question 6.3 asks whether you have an acceptable project schedule or whether you would
like the SWAMP Advisor to help you to develop one. Select the second choice to let the
SWAMP Advisor help to prepare a schedule table. This will allow you to build a
schedule table with four separate activities. Although you will probably have more
than four activities, once the table is built for you then it is easier to simply add more
rows to the bottom of it and enter the appropriate information in them in the text
document than to continue to add more activities using the SWAMP Advisor.

Question 6.3.1.1.a asks you to enter the name of the first activity in your schedule table.
For this exercise enter “Field sampling” and click on the “OK” button to continue.

Question 6.3.1.1b asks you to enter the initiation date of the first activity. Enter an
example date of 1/5/2009 and click on the “OK” button.

Question 6.3.1.1c asks you to enter the completion date of the first activity. Enter an
example date of 3/1/2009 and click on the “OK” button.

Question 6.3.1.1d asks you to enter the deliverable of the first activity. Enter an example
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of “Field Data Report” and click on the “OK” button.

Question 6.3.1.1e asks you to enter the due date of the deliverable. Enter an example date
of 4/1/2009 and click on the “OK” button. This completes the information for the first
activity in the schedule table. The same questions will be asked again three more
times to enable you to enter three more activities in the schedule table.

The Question Numbers for the repeat questions are 6.3.1.2a through 6.3.1.2e, and
6.3.1.3a through 6.3.1.3e, and 6.3.1.4a through 6.3.1.4e. Enter information for each of
these questions and click on the “OK” button to continue after each entry.

Question 6.3.1 asks you to provide a brief explanation of the scheduling of key project
events. A useful example in the right side screen may be copied and pasted, after
appropriate edits for your plans, in the space provided in the left side screen. Click on the
“OK” button to continue.

Question 6.4.1 asks you to provide a description of the general geographic location of the
project sampling. A useful example in the right side screen may be copied and pasted,
after appropriate edits for your plans, in the space provided in the left side screen. Click
on the “OK” button to continue.

Question 6.4.2 asks you to provide captions for any maps and photographs that you use in
Element 6. These will serve to remind you where the figures should go. If you do not
plan to use maps or photographs then state that fact in the space provided and click on the
“OK” button.

Question 6.5.1 asks you to select any of the typical constraints that could negatively
affect your project. Select any that you feel are appropriate and pre-formatted text will be
inserted into your text document describing these. You may preview these statements
from a link in the right side screen. If you select “Other constraints” then you will be able
to describe your own constraints.

Question 6.6 asks if you want to review all your answers. Select “Yes” and click on the
“OK” button to see all of them.

Click on the *“OK” button when you are finished reviewing the displayed draft
information.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 6 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
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file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “6-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then page down to where you see the instructions:

R Begin Highlighting Table for Formatting Below This Line ------------ >
and
S End Highlighting Table for Formatting Above This Line --------------- >

for the table.

Highlight the text between the two instructions as indicated.
Hint: if you highlight from the bottom right of the text area to the top left of the
text area then you will avoid including an extra space at the bottom right in your
highlighted area. If you do have an extra space in the bottom right highlighted
area then it may sometimes cause an extra empty row to appear in your formatted
table.

After highlighting the text that will be in the table, then click on “Table” in your MS
Word toolbar.

Next, select “Convert” from the drop down menu.

Next select “Text to Table” from the sub-menu.

If you highlighted the table text correctly then you will see a correctly completed
“Convert Text to Table” box in which the bottom row information has “Separate text at”

with the “Commas” button selected.

Click on the *“OK” button and the comma-delimited text will instantly be converted to a
“regular” table format.

After the table has been formatted to regular table format then delete the arrows with
instructions above and below each table.

This completes the work with Element 6.
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5.7 Element 7 — Quality Objectives and Criteria for Measurement
Data

5.7.1 - Content Checklist for Element 7

In order to complete this section, you will need the following information:

e A statement of your Data Quality Objectives.
e A statement of your Measurement Quality Objectives.
e A list of analytes to be measured.

5.7.2 - Instructions for Element 7

The first screen (7.0.1) of this element provides background information and two
references that may be helpful as you develop answers for this section of your QAPP.

Question 7.0.2 asks how many study questions (or lines of inquiry) there are for your
project. For this exercise assume that there are two: first, water quality assessment and,
second, determining the source of pollution that will be monitored. Therefore, of the two
possible selections, choose the one with multiple study questions and click on the “OK”
button.

Question 7.1 provides background information for developing Data Quality Objectives.
Read or download as many of the documents in the right screen as you need in order to
understand this important and complex process and then click on the “OK” button to
proceed.

Question 7.2.1 asks for a concise statement of the first study question. As an example,
you may enter “Water Quality Assessment” and then click on the “OK” button. This
statement will be entered into your Element 7 text document and you will copy and paste
it into the first column of each of the tables that relate to this monitoring data.

Question 7.2.2 asks for an initial Data Quality Objective (DQO). A generic example in
the right side screen may be copied and pasted, after appropriate edits for your plans, in
the space provided in the left side screen. The DQO process is an iterative one and you
should return later and revise it to make it specific for your planned project. Click on the
“OK” button to continue.

Question 7.3 asks you to describe your Measurement Quality Objectives (MQOs). A
generic example in the right side screen may be copied and pasted, after appropriate edits
for your plans, in the space provided in the left side screen. Click on the “OK” button to
continue.

Question 7.4 asks you to select which “groups” of analytical parameters you will use for
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the study question. Since, in this example, water quality monitoring will be conducted,
the appropriate selection is “Discrete Field Methods” and the link on the right side screen
provides additional support for this choice. Select this choice and click on the “OK”
button to proceed.

Question 7.5 lists available field measurement parameters. There are only two at present
— more will be added later. Select the two top choices and click on the “OK” button.
Questions involving each parameter will be provided in sequence.

Question 7.5.1 lists several commonly used instruments for measuring specific
conductivity. MQOs are specific for each instrument because they all have difference
performance characteristics. Select any that you wish and the MQO information for each
selected automatically will be entered into your Element 7 text document tables.

Question 7.5.2 lists several commonly used instruments for measuring temperature.
MQOs are specific for each instrument because they all have difference performance
characteristics. Select any that you wish and the MQO information for each selected
automatically will be entered into your Element 7 text document tables.

A preview of your answers so far will be displayed. When you have completed your
review of the displayed draft information then the next question asks if you want to save
the draft text that you just reviewed to a “Rich Text Format” (RTF) file. Select “Yes” and
click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor
will compile your answers into a correctly formatted document for Element 7 and send it
to your browser. If you do not see this happen then check Section 1.1 for solutions to the
problem. Possible problems include your browser not having the tool bar options tab
checked to download documents, a pop-up blocker not being deactivated, a security
system such as in Internet Explorer’s Version 7 blocking the file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, *7-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then page down to where you see the instructions:

G Begin Highlighting Table for Formatting Below This Line ------------ >
and
S End Highlighting Table for Formatting Above This Line --------------- >

for the table.
Highlight the text between the two instructions as indicated.

Hint: if you highlight from the bottom right of the text area to the top left of the
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text area then you will avoid including an extra space at the bottom right in your
highlighted area. If you do have an extra space in the bottom right highlighted
area then it may sometimes cause an extra empty row to appear in your formatted
table.

After highlighting the text that will be in the table, then click on “Table” in your MS
Word toolbar.

Next, select “Convert” from the drop down menu.
Next select “Text to Table” from the sub-menu.

If you highlighted the table text correctly then you will see a correctly completed
“Convert Text to Table” box in which the bottom row information has “Separate text at”
with the “Commas” button selected.

Click on the “OK” button and the comma-delimited text will instantly be converted to a
“regular” table format.

After the table has been formatted to regular table format then delete the arrows with
instructions above and below each table.

Question 7.7 asks if you wish to loop through the questions again for a different study
question. Since this exercise has only completed the first of two study questions, select
“Yes” and click on the “OK” button.

This action returns you to Question 7.2.1 and your initial answer is present. The second
study question involves monitoring to discover the source of pollutants so delete the
residual answer and replace it with “Source ID” and click on the “OK” button.

Question 7.2.2 contains the original DQO statement which may be retained. Click on the
“OK” button to continue.

Question 7.2.3 contains the original MQO statement which may be retained. Click on the
“OK?” button to continue.

Question 7.4 is the “Group Menu” and laboratory measurements will be used for the
Source Identification Study Question. Therefore, “uncheck’” the box marked “Discrete
Field Methods” by clicking on it again and check the box marked “Laboratory
measurements” then click on the “OK” button.

Question 7.6 presents a list of analytes that are analyzed in a laboratory. Select any that
you wish. You are next presented a preview of your answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
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Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 7 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” but DO NOT NAME
THIS SECOND STUDY QUESTION FILE 7-QAPP. The reason is that you have
already saved the document file from the first study question by that name and if you use
it again you will copy over the first file. Instead, name this file, “7a-QAPP.rtf” so that it
will be saved to the file folder that you have created for your QAPP files.

Remember that you will have to copy and paste the information from this file into your
Master QAPP document because the macro in your CoverPage.doc file was not instructed
to find multiple files for a given element to append. This feature will be added, if
possible, in the future.

You will be returned to Question 7.7. This time choose “No, | am finished” and click on
the “OK” button.

This completes the work with Element 7. You will later copy some of the tables from
Element 7 to other element text documents after you complete them. Each will contain a
reminder for you.

5.8 Element 8 — Special Training Needs / Certification

5.8.1 - Content Checklist for Element 8

In order to complete this section, you will need the following information:

Lists of special training that is relevant to your monitoring plan.

Lists of who received training.

Lists of who provided training

Lists of any training records or certificates relevant to your monitoring plan.
Information on where training records or certificates are kept.

Lists of training course titles or topics

5.8.2 - Instructions for Element 8

The first screen (8.1) of this element asks if your project will require special training
needs or certification. If you select “No” then you will be able to explain why you do not
need this. For this exercise select “Yes” and click on the “OK” button.
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Question 8.1 asks you to briefly describe the special training that is needed. A useful
example in the right side screen may be copied and pasted, after appropriate edits for
your plans, in the space provided in the left side screen. Click on the “OK” button to
continue.

Question 8.2 asks if you will need training or certification documents. If you choose
“Yes” then you will be able to describe them and where they are located. For this
exercise select “No” and click on the “OK” button. The next screen asks you to explain
why you do not need training or certification documents. A useful example in the right
side screen may be copied and pasted, after appropriate edits for your plans, in the space
provided in the left side screen. Click on the “OK” button to continue.

Question 8.3 asks if you will identify training personnel. If you choose “No” then you
will be able to explain why you do not need to identify them. For this exercise select
“Yes” and click on the “OK” button. The next screen asks you to briefly describe the
kinds of training personnel that will be needed. A useful example in the right side screen
may be copied and pasted, after appropriate edits for your plans, in the space provided in
the left side screen. Click on the “OK” button to continue.

This leads you to Question 8.3.1 where you may list the training courses in tabular
format. For this exercise select this option and click on the “OK” button.

Question 8.3.1a asks for the title of the first course. Enter the information and click on the
“OK” button. Remember, no commas may be used in entering any information into
comma-delimited data. An example could be, “Basic Sampling Techniques” if you wish.

Question 8.3.1b asks for the name of the training provider (the organization). Enter the
information and click on the “OK” button. An example could be, “The Sample Training
Company” if you wish.

Question 8.3.1c asks who took the training. Enter the information and click on the “OK”
button. An example could be, “Sampling Team Leaders” if you wish.

Question 8.3.1d asks for the location of the records and certificates from this training
course. Enter the information and click on the “OK” button. An example could be, “The
Concerned Citizens Organization” if you wish.

Questions 8.3.2a through 8.3.2d repeat the same questions for the second training course.
Complete each of the answers as you did previously.

Questions 8.3.3a through 8.3.3d repeat the same questions for the third training course.
Complete each of the answers as you did previously.

Click on the “OK” button when you are finished reviewing the displayed draft
information.
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When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 6 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “8-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then page down to where you see the instructions:

R Begin Highlighting Table for Formatting Below This Line ------------ >
and
oo End Highlighting Table for Formatting Above This Line --------------- >

for the table.

Highlight the text between the two instructions as indicated.
Hint: if you highlight from the bottom right of the text area to the top left of the
text area then you will avoid including an extra space at the bottom right in your
highlighted area. If you do have an extra space in the bottom right highlighted
area then it may sometimes cause an extra empty row to appear in your formatted
table.

After highlighting the text that will be in the table, then click on “Table” in your MS
Word toolbar.

Next, select “Convert” from the drop down menu.

Next select “Text to Table” from the sub-menu.

If you highlighted the table text correctly then you will see a correctly completed
“Convert Text to Table” box in which the bottom row information has “Separate text at”

with the “Commas” button selected.

Click on the “OK” button and the comma-delimited text will instantly be converted to a
“regular” table format.
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After the table has been formatted to regular table format then delete the arrows with
instructions above and below each table.

This completes the work with Element 8.

5.9 Element 9 — Documents and Records

5.9.1 - Content Checklist for Element 9

In order to complete this section, you will need the following information:

e Alist of all the types of data records that will be maintained with your project

A list of to whom you will distribute your approved QAPP copies and how they will
be provided to these individuals

A list of who is responsible for archiving each type of data record

A list of where each type of record will be archived

A list of how long each type of record will be archived

A list of how each type of type of record will ultimately be disposed of

5.9.2 - Instructions for Element 9

The first screen (9.0) of this element asks you to describe who (either a person,
organization, or both) will be responsible for maintaining and updating this QAPP. A
useful example in the right side screen may be copied and pasted, after appropriate edits
for your plans, in the space provided in the left side screen. Click on the “OK” button to
continue.

Question 9.01 asks for a brief description of the general types of data records that will be
maintained as part of your QAPP. You will be able to select specific examples or
describe them in your own words with the next questions. A useful example in the right
side screen may be copied and pasted, after appropriate edits for your plans, in the space
provided in the left side screen. Click on the “OK” button to continue.

Question 9.1 asks for a brief description of the process by which you will distribute
copies of an approved QAPP and to whom (person and organization) they will be given.
A useful example in the right side screen may be copied and pasted, after appropriate
edits for your plans, in the space provided in the left side screen. Click on the “OK”
button to continue.

Question 9.2 lists six of the most common types of records that require documentation.
The seventh choice “Other” will allow you to provide additional reports that you may
plan to document. For this exercise check the boxes for “Field records” and “Analytical
laboratory records.” Then click on the “OK” button
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Question 9.2.2 asks you to describe your plans for retaining, archiving and disposing of
field records. Enter this information and then click on the “OK” button.

Question 9.2 — First Table Input asks if you would like to include your plans for field
records in tabular format. Select “Yes” and click on the “OK” button.

Question 9.2.2.1 asks you for the first field record type. Enter “field notebooks” and click
on the “OK” button.

Question 9.2 — Records Retention asks how long you will retain these records. Since
SWAMP recommends at least 8 years then enter that number and click on the “OK”
button to continue.

Question 9.2 — Records Archival asks where you will keep these records. Enter the
location and click on the “OK” button.

Question 9.2 — Records Disposition asks how you will dispose of them. Enter
“shredding” and click on the “OK” button to continue.

Question 9.2 — Another Table Input asks if you want to include another row of
information for field records. Select “No” and click on the “OK” button.

Question 9.2.3 asks you to describe your plans for retaining, archiving and disposing of
laboratory analytical records. Enter this information and then click on the “OK” button.

Question 9.2 — First Table Input asks if you would like to include your plans for
laboratory analytical records in tabular format. Select “No” and click on the “OK” button.
This time you will not be asked for tabular input information.

Question 9.3 asks you to identify the individuals and organizations that will be
responsible for maintaining each type of project record. A useful example in the right
side screen may be copied and pasted, after appropriate edits for your plans, in the space
provided in the left side screen. Click on the “OK” button to continue.

Question 9.4 asks for a description of where project records will be stored, how long, and
how they will ultimately be disposed of. A useful example in the right side screen may be
copied and pasted, after appropriate edits for your plans, in the space provided in the left
side screen. Click on the “OK” button to continue.

Question 9.5 asks for a description of who is responsible for archiving each type of
project record. A useful example in the right side screen may be copied and pasted, after
appropriate edits for your plans, in the space provided in the left side screen. Click on the
“OK” button to continue.

Question 9.6 asks whether any of the records will be stored in an electronic format. Since
this is usually the case, select “Yes” and click on the “OK” button.
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Question 9.7 asks for a description of the responsible people and place of storage for
electronic records. A useful example in the right side screen may be copied and pasted,
after appropriate edits for your plans, in the space provided in the left side screen. Click
on the “OK” button to continue. You will next be shown all of your draft answers.

Click on the “OK” button when you are finished reviewing the displayed draft
information.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 6 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “9-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then page down to where you see the instructions:

oo Begin Highlighting Table for Formatting Below This Line ------------ >
and
S End Highlighting Table for Formatting Above This Line --------------- >

for the table.

Highlight the text between the two instructions as indicated.
Hint: if you highlight from the bottom right of the text area to the top left of the
text area then you will avoid including an extra space at the bottom right in your
highlighted area. If you do have an extra space in the bottom right highlighted
area then it may sometimes cause an extra empty row to appear in your formatted
table.

After highlighting the text that will be in the table, then click on “Table” in your MS
Word toolbar.

Next, select “Convert” from the drop down menu.
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Next select “Text to Table” from the sub-menu.

If you highlighted the table text correctly then you will see a correctly completed
“Convert Text to Table” box in which the bottom row information has “Separate text at”
with the “Commas” button selected.

Click on the “OK” button and the comma-delimited text will instantly be converted to a
“regular” table format.

After the table has been formatted to regular table format then delete the arrows with
instructions above and below each table.

This completes the work with Element 9.

5.10 Element 10 — Sampling Process Design

5.10.1 - Content Checklist for Element 10

In order to complete this section, you will need the following information:

The type of sampling stations planned to be used.
Why you selected planned sampling stations.

The reason for your timing selection.

The design principal for reach selection.

The design principal for station selection.

The design principal for selection for seasonal selection.
The design principal for selection of diurnal selection.
On-site observations that are planned

The total number of estimated site visits.

The frequency of visits to sampling stations.

The time interval between visits to sampling stations.

Whether or not you plan to use continuous monitoring devices and, if so, what they
are.

A description of what, when and where you plan to visit the sampling area.

A list of potential sources of uncertainty in your planned data collection.

A description of important logistics schedule information

A list of critical information for your planned project.

5.10.2 - Instructions for Element 10

The first screen (10.0) of this element asks whether there is one or more than one study
question. From Element 5 and 7 exercises you recall that there are two study questions.
One involves field analysis for water quality measurements and the other involves
laboratory analysis to try to determine the identification of the source of selected
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chemical analytes. However, to save time we are going to combine them in the
experimental design of the sampling process. Select “More than one study question” and
click the “OK” button. The Advisor lets you know that you need to go through Element
10 questions as many times as there are study questions. Click on the “OK” button to
continue.

Question 10.1 asks you to enter the study question. This will be part of a pre-formatted
sentence. In the space provided type “water quality of the project’s study area” or any
other study question that you wish to enter.

Question 10.2 asks you to identify the types of stations that will be used for sampling.
Enter your answer using the information in the right side screen or any other source of
information that is appropriate.

Question 10.3 asks why you are selecting the sampling station locations that you plan to
use. Select an appropriate answer. Based on the study question “Impact assessment” is
one answer that would apply. Click on the “OK” button to continue.

Question 10.4 asks your timing selection intent. Routine monitoring would be one answer
that would apply. Please select your answer and click on the “OK” button.

Question 10.5 asks you to select the sampling design principle for your reach selection.
“Directed to the environment” is one answer that could apply. Click on the “OK” button
to continue.

Question 10.6 asks you to select the sampling design principle for your station selection.
“Directed to the environment” is one answer that could apply. Click on the “OK” button
to continue.

Question 10.7 asks you to select the sampling design principle for your seasonal
selection. “Directed to the environment” is one answer that could apply. Click on the
“OK” button to continue.

Question 10.8 asks you to select the sampling design principle for your diurnal selection.
“Systematic” is one answer that could apply. Click on the “OK” button to continue.

Question 10.9 asks you to describe what on-site observations or other relevant
measurements you plan to record. A useful example in the right side screen may be
copied and pasted, after appropriate edits for your plans, in the space provided in the left
side screen. Click on the “OK” button to continue.

Question 10.10 asks you to enter the number of site visits you plan to make. You may
enter just a number if you wish — your entry will complete a pre-formatted sentence.
Click on the “OK” button to continue.

Question 10.11 asks for you to enter the frequency at which the sampling stations will be
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visited. Using the information in the right side screen enter your answer and click on the
“OK” button to continue.

Question 10.12 asks you to enter the planned interval between your visits. Using the
information in the right side screen enter your answer and click on the “OK” button to
continue.

Question 10.13 asks you to describe your continuous monitoring devices or, if you do not
plan to use them then state that decision. Click the “OK” button to continue.

Question 10.14 asks you to provide a brief work statement of who will do what, when
and where. Some examples are provided in the right side screen. Enter your answer and
click on the “OK” button.

Question 10.15 asks you to provide a brief statement of potential sources of uncertainty.
Useful information is provided in the right side screen. Enter your answer and click on
the “OK” key.

Question 10.16 asks you to identify important logistics schedules. This information is
typically found in your monitoring plan and you may reference that document or enter
your own information. Then click on the “OK” button to continue.

Question 10.17 asks you to list what information is critical to your study and what is for
informational purposes only. Enter this information and then click on “OK” button. A
draft of your answers will immediately be presented for your review.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 10 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “10-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then Question 10.18 asks if you want to loop through the
questions again for another study question. Since there are two study questions involved
in this example exercise, and you have just completed the first one, select “Yes” and you
will loop though the same 17 questions again. Change those that are applicable for
laboratory analysis of analytes to determine the source identification of them.
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Again you will be presented with a review of your second draft information. When you
have completed your review of the displayed draft information then the next question
asks if you want to save the draft text that you just reviewed to a “Rich Text Format”
(RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK”
button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 10 and send it to your browser.

Click on the “File” tab in the MS Word file, select “Save As” but DO NOT NAME
THIS SECOND STUDY QUESTION FILE 10-QAPP. The reason is that you have
already saved the document file from the first study question by that name and if you use
it again you will copy over the first file. Instead, name this file, “10a-QAPP.rtf” so that it
will be saved to the file folder that you have created for your QAPP files.

Remember that you will have to copy and paste the information from this file into your
Master QAPP document because the macro in your CoverPage.doc file was not instructed
to find multiple files for a given element to append. This feature will be added, if
possible, in the future.

You will be returned to Question 10.18. This time choose “No, I am finished” and click
on the “OK” button.

This completes the work with Element 10

5.11 Element 11 — Sampling Methods

5.11.1 - Content Checklist for Element 11

In order to complete this section, you will need the following information:

e A summary of plans for collecting samples of water, sediment and tissue as

applicable.

A summary of sterilization of containers, or their commercial source, if applicable.

A summary of field sample preparations or manipulations if applicable.

A list of sample containers and their volumes for all media sampled.

A summary of sample preparation plans for all media sampled.

A summary of container cleaning plans, or their commercial source, if applicable.

A summary of plans for sample labeling for all sample containers.

A list of any sampling equipment and its cleaning procedures if applicable.

A summary of plans for disposing of sampling equipment cleaning byproducts if

applicable.

e A summary of corrective actions, and person(s) responsible if sampling problems
occur.

e A list of SOPs that apply to sampling methods.
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5.11.2 - Instructions for Element 11

The first screen 11.0 asks you to select which of three U.S. EPA-defined “media” you
plan to sample (water, air, and/or sediment). Select all three media for this exercise and
click on the “OK” button.

Question 11.1.1 asks you to briefly summarize your plans for collecting water samples.
Advice and information, including links to the SWAMP Field Methods Course (a tutorial
with slides and audio) is provided in the right side screen. Please enter your information
or, if it is in your Monitoring Plan, reference that source and then click on the “OK”
button.

Question 11.5 asks if sterile containers will be used. Select “Yes” and click on the “OK”
button.

Question 11.5.1 asks whether you will purchase sterile containers or sterilize them
yourself and, whatever the case, to describe how you can be certain that they are sterile.
The right side screen contains useful information for answering this question. After
entering your response then click on the “OK” button.

Question 11.1.2 asks you to briefly summarize your plans for collecting sediment
samples. Advice and information, including links to the SWAMP Field Methods Course
is provided in the right side screen. Please enter your information or, if it is in your
Monitoring Plan, reference that source and then click on the “OK” button.

Question 11.1.3 asks you to briefly summarize your plans for collecting tissue samples.
Advice and information, including links to SWAMP method requirements from the
SWAMP web site is provided in the right side screen. Please enter your information or, if
it is in your Monitoring Plan, reference that source and then click on the “OK” button.

Question 11.2 asks whether any samples will be processed or prepared in the field. Select
“Yes” to this question and click on the “OK” button.

Question 11.2.1 asks you to describe what field preparations or manipulations will be
conducted (and on samples from which media). Please enter your information and click
on the "OK" button.

Question 11.3 asks you to describe each kind of container and sample volumes for each
media that will be sampled. Note that important information is provided in the right side
screen (including a link to text that you may copy and paste). Please enter your
information and click on the "OK" button.

Question 11.4 asks if any of your samples will be preserved — this includes cooling
samples. Select “Yes” and click on the "OK" button.

Question 11.4.1 asks you to describe all of your sample preservation plans. Note that the
information in the right side screen advises that you may reference the information in
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Table 12.1 that was automatically generated for you in Element 7. Please enter your
information and click on the "OK" button.

Question 11.5.2 asks you to describe your sample container cleaning procedures. If you
plan to use pre-cleaned commercial containers then provide the name of their source.
Please enter your information and click on the "OK" button.

Question 11.6 asks you to describe your procedure to ensure unique sample number
labels. Please enter your information and click on the "OK" button.

Question 11.7 asks whether sampling equipment will be used to help you gather samples.
Select “Yes” and click on the "OK" button.

Question 11.7.1 asks you to list sampling equipment that will be used and how you plan
to clean it. Review the information available in the right side screen link for ideas, enter
your answer in the space provided in the left screen and click on the "OK" button to
continue.

Question 11.7.2 is a result of your answer to questions 11.7 and 11.7.1 because if you
clean sampling equipment then you will have byproducts of this process to dispose of.
Click on the link in the right side screen to help you formulate your answer — you may
find that some of the text may be copied and pasted with appropriate edits. Enter your
answer in the space provided in the left screen and click on the "OK" button to continue.

Question 11.8 asks for a description of the corrective actions to be followed if sampling
problems occur. Click on the link in the right side screen to help you formulate your
answer — you may find that some of the text may be copied and pasted with appropriate
edits. Enter your answer in the space provided in the left screen and click on the "OK"
button to continue.

Question 11.9 asks for a list of SOPs that involve sampling methods. If you have this
information referenced in your Monitoring Plan you may refer to it here or enter your
answer in the space provided in the left screen and click on the "OK" button to continue.

Question 11.10 alerts you to the fact that you are finished entering information into
Element 11. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 11 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.
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Click on the “File” tab in the MS Word file, select “Save As” and name this file, “11-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 11.

5.12 Element 12 — Sample Handling and Custody

5.12.1 - Content Checklist for Element 12

In order to complete this section, you will need the following information:

e Your Monitoring Plan to refer to procedures that you have documented for sample
handling and custody.

5.12.2 - Instructions for Element 12

The first screen 12.1 asks for the name of the person with ultimate responsibility for
sample handing and custody. Enter that person’s name and click on the "OK" button.

Question 12.1.1 asks you to select how sample handling information will be documented.
Click on the link in the right side screen to view the pre-formatted text. Then select “Both
field notebooks and forms will be used” and click on the "OK" button.

Question 12.2 asks if chain-of-custody forms will be used. These are necessary for a
SWAMP-Comparable QAPP. Click on the link in the right side screen to see the pre-
formatted text. Then select “Yes” and click on the "OK" button.

Question 12.3 asks if the laboratory will use chain-of-custody procedures to track
samples. These are necessary for a SWAMP-Comparable QAPP. Click on the link in the
right side screen to see the pre-formatted text. Then select “Yes” and click on the "OK"
button.

Question 12.4 asks if samples will be packed in ice and cooled. This is necessary for a
SWAMP-Comparable QAPP. Click on the link in the right side screen to see the pre-
formatted text. Then select “Yes” and click on the "OK™" button.

Question 12.5 asks if shipping containers will be prepared and sealed according to
SWAMP recommendations. This is necessary for a SWAMP-Comparable QAPP. Click
on the link in the right side screen to see the pre-formatted text. Then select “Yes” and
click on the "OK" button.

Question 12.6 asks how samples will be transported to the laboratory. Click on the link in
the right side screen to see the pre-formatted text. Then select your answer and click on
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the "OK" button.

Question 12.7 alerts you to the fact that you are finished entering information into
Element 12. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 12 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “12-

QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 12.

5.13 Element 13 — Method Selection

5.13.1 - Content Checklist for Element 13

In order to complete this section, you will need the following information:

e The name of the laboratory that will conduct analyses on the planned samples.

e A description of the methods that are planned to be used and information from your
Monitoring Plan concerning your sampling stations.

e A copy of the laboratory’s SOP for handling and documenting method failures.

e Alist of turn around times for various planned sample analyses.

e A description of how the laboratory handles its waste from your samples including a
reference to the lab’s SOP.

5.13.2 - Instructions for Element 13

The first screen (13.1) asks whether either in-situ or continuous monitoring procedures
will be used. Select “Yes” and click on the "OK" button.

Question 13.1.1 asks which of the two will be used. Check both of the boxes and click on
the "OK" button.

Question 13.1.1A asks if there are any known physical impediments to obtaining
representative data from sampling stations where in-situ sampling will be conducted.
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Select “No” and click on the "OK" button.

Question 13.1.1B asks if here are any known physical impediments to obtaining
representative data from sampling stations where continuous sampling will be conducted.
Select “No” and click on the "OK" button.

Question 13.2 asks if there are any field methods that will be used that were not already
included in Table 13.1 (which was automatically generated in Element 7)? Select “No”
and click on the "OK" button.

Question 13.3 asks that you insert the name of the laboratory that will conduct the
proposed analyses. Enter the lab’s name and click on the "OK" button.

Question 13.4 asks if there are any laboratory methods that will be used that were not
already included in Table 13.2 (which was automatically generated in Element 7)? Select
“No” and click on the "OK" button.

Question 13.5 asks if there will be any modified methods that will be used. Click on the
link in the right side screen to view the pre-formatted text for the situation in which no
modified methods are planned and then select “Unmodified promulgated methods will be
used” and click on the "OK" button.

Question 13.6 asks you to enter the person’s name who will be responsible for corrective
action if a laboratory method fails to perform as needed. Enter the name and click on the
"OK" button.

Question 13.6.1 asks for a summary of the procedures that the laboratory has in place and
that will be used in the event of method failure. Click on the link in the right side screen
to view text that you may copy and paste, with appropriate edits. Enter your answer in
the left side screen and click on the "OK" button.

Question 13.6.2 asks for a summary of the documentation procedures that the laboratory
has in place and that will be used in the event of method failure. Click on the link in the

right side screen to view text that you may copy and paste, with appropriate edits. Enter

your answer in the left side screen and click on the "OK" button.

Question 13.7 asks for a summary of how the laboratory manages disposal of its wastes.
Click on the link in the right side screen to view text that you may copy and paste, with
appropriate edits. Enter your answer in the left side screen and click on the "OK" button.

Question 13.8.1 asks for a summary of the turn around time needed for sample analysis.
Click on the link in the right side screen to view text that you may copy and paste, with
appropriate edits. Enter your answer in the left side screen and click on the "OK" button.

Question 13.8.2 asks you to select the status of your discussions about turn around time
with the laboratory. Select the appropriate answer and click on the "OK" button.
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Question 13.9 alerts you to the fact that you are finished entering information into
Element 13. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 13 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “13-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 13.

5.14 Element 14 — Quality Control

5.14.1 - Content Checklist for Element 14

In order to complete this section, you will need the following information:

e Alist of the types of quality control samples needed for your project.

5.14.2 - Instructions for Element 14

The first screen (14.1) asks if there are additional measurement parameters and quality
control (QC) data other than those automatically generated in Element 7 and placed in
Table 14.1. Read the pre-formatted text from the link in the right side screen. Select “No”
and click on the "OK" button.

Question 14.2 asks if you would like the SWAMP Advisor to add pre-formatted text with
additional QC samples that you plan to use versus your own written descriptions. Read
the pre-formatted text from the link in the right side screen. Select “Yes” and click on the
"OK" button.

Question 14.2.1 provides a menu with eleven commonly used types of QC samples.
Select all that apply and click on the "OK™" button. Pre-formatted text shown from the link
on the right side screen will automatically be inserted into your text document for each
type of QC sample selected.
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Question 14.3 asks if one of your objectives is to determine whether the analytes being
monitored are in “elevated” concentrations over “normal” environmental concentrations.
Click on the link to read the pre-formatted text, then select “Yes” and click on the "OK"
button.

Question 14.4 alerts you to the fact that you are finished entering information into
Element 14. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 14 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “14-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 14.

5.15 Element 15, 16, & 17 — Inspection, Calibration, and Supplies

5.15.1 - Content Checklist for Elements 15, 16, & 17

In order to complete this section, you will need the following information:

e A list of people who will be responsible for testing instruments and field equipment,
for calibration of laboratory instruments, and for inspection and acceptance of
supplies and consumables.

5.15.2 - Instructions for Elements 15, 16, & 17

The first screen (15.1) asks if you plan to include field measurements with your project.
Click on the link in the right side screen, read the pre-formatted text. Then select “Yes”
and click on the "OK" button.

Question 15.1B asks for the name of the person who will be responsible for instrument
and equipment testing for field measurements. Enter the person’s name and click on the
"OK" button.

Question 16.1 lists eight commonly measured field parameters. Click on the link in the
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right side screen to read the pre-formatted text. Then check all that apply and click on the
"OK" button.

Question 15.2 asks if laboratory measurements will be made. Click on the link on the
right side screen to read the pre-formatted text. Then select “Yes” and click on the "OK"
button.

Question 16.1B asks you to name the person who will be responsible for instrument and
equipment calibration at the necessary frequencies. Enter the name(s) and click on the
"OK" button.

Question 16.2 provides a menu of common parameters that are measured in the
laboratory. Click on the link in the right side screen to read the pre-formatted text. Check
all that apply and click on the "OK" button.

Question 15.3 asks if you plan to measure biological organisms (bacteria and/or benthic
organisms). Click on the link in the right side screen to read the pre-formatted text and
then select “Yes” and click on the "OK" button.

Question 16.3 asks you to select which types of biological organisms you plan to
monitor. Click on the link in the right side screen to read the pre-formatted text. Check all
that apply and click on the "OK" button.

Question 17.1 asks if there are any critical supplies with your planned project. Click on
the link in the right side screen to read the pre-formatted text. Select “Yes” and click on
the "OK" button.

Question 17.1B results from your selection of “Yes” in the previous question. Enter the
name of the person who will be responsible for inspection and acceptance of supplies and
consumables and click on the "OK" button.

Question 17.2 alerts you to the fact that you are finished entering information into
Elements 15, 16, and 17. Select “Yes” and click on the "OK" button to review your draft
answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Elements 15, 16, and 17 and send it to your browser. If you do not see this
happen then check Section 1.1 for solutions to the problem. Possible problems include
your browser not having the tool bar options tab checked to download documents, a pop-
up blocker not being deactivated, a security system such as in Internet Explorer’s Version
7 blocking the file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file,
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“151617-QAPP.rtf” so that it will be saved to the file folder that you have created for
your QAPRP files.

After the file has been saved then that completes the work with Elements 15, 16, and 17.

5.16 Element 18 — External Data

5.16.1 - Content Checklist for Element 18

In order to complete this section, you will need the following information:

A list of sources of external data that will be used.

Name of the projects from which external data will be used.
Acceptance criteria for using external data.

Limits on data that fail acceptance criteria.

Any constraints on using external data.

5.16.2 - Instructions for Element 18

The first screen (18.1) asks if you know where your external data will come from. Read
the pre-formatted text in the right side screen, select “Yes,” and click on the "OK" button.

Question 18.1.1 provides a menu with 8 typical sources of external data and “Other
sources” (which allows you to describe your own source). Click on the link in the right
side screen to read the pre-formatted text and then select “Existing data from a previous
effort” and click on the "OK" button.

Question 18.1.7 asks you to name the project and summarize the data that you will use.
Enter the requested information and click on the "OK" button.

Question 18.2 asks how you plan to use the external data. Enter the requested information
and click on the "OK" button.

Question 18.3 asks what kinds of acceptance criteria will be used to accept external data
for use on the planned project. Click on the link in the right side screen to read the pre-
formatted text, check all answers that apply, and click on the "OK" button.

Question 18.4 asks what limits will be put on data that fail your acceptance criteria. Click
on the link in the right side screen to read the pre-formatted text, check all answers that
apply, and click on the "OK" button.

Question 18.5 asks if there are any constraints on your ability to obtain and use the

external data. Click on the link in the right side screen to read the pre-formatted text,
select “No,” and click on the "OK" button.
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Question 18.6 asks if there are any key resources, equipment or facilities that would
inhibit your ability to use the external data. Click on the link in the right side screen to
read the pre-formatted text, select “No,” and click on the "OK" button.

Question 18.7 alerts you to the fact that you are finished entering information into
Element 18. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 18 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “18-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 18.

5.17 Element 19 — Data Management

5.17.1 - Content Checklist for Element 19

In order to complete this section, you will need the following information:

e SOPs for field data management, continuous measurement data management, and
laboratory data management.

5.17.2 - Instructions for Element 19

The first screen (19.0) provides a menu to select which types of measurements you will
need data management for. For this exercise please select all three and click on the "OK"
button.

Question 19.1.0 asks if you have a SOP for field data management. Select “Yes” and
click on the "OK" button.

Question 19.1.0A asks you to type the title and SOP reference number. Note that this

information will be appended to the end of the sentence shown in the right side screen
and inserted into your text document. After your entry is made then click on the “OK”
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button to continue.

Question 19.1.1 asks if the SOP describes what standard practices will be used for record
keeping and data tracking of field data. Click on the link in the right side screen to view
the pre-formatted text that will be inserted into your text document, select “Yes” and
click on the "OK" button.

Question 19.1.2 asks if your SOP identifies data handing equipment and/or procedures
for processing, analyzing, compiling, and/or transmitting field analytical data. on the link
in the right side screen to view the pre-formatted text that will be inserted into your text
document, select “Yes” and click on the "OK" button.

Question 19.1.3 asks if your SOP describes how field measurement data will be
formatted and entered (or prepared for uploading) into the SWMP Information
Management System. Click on the link in the right side screen to view the pre-formatted
text that will be inserted into your text document, select “Yes” and click on the "OK"
button.

Question 19.1.4 asks if your SOP conforms to the SWAMP Information Management
System requirements for using standardized data sheets. Click on the link in the right side
screen to view the pre-formatted text that will be inserted into your text document, select
“Yes” and click on the "OK" button.

Question 19.1.5 asks you to enter the name of the person who will be responsible for
management of the field data. Note that this name will be appended to the sentence
shown in the right side screen. Enter the person’s name and click on the "OK" button.

Question 19.2.0 asks if you have a SOP for continuous monitoring data management.
Select “Yes” and click on the "OK" button.

Question 19.2.0A asks you to type the title and SOP reference number. Note that this
information will be appended to the end of the sentence shown in the right side screen
and inserted into your text document. After your entry is made then click on the “OK”
button to continue.

Question 19.2.1 asks if the SOP describes what standard practices will be used for record
keeping and data tracking of continuous monitoring data. Click on the link in the right
side screen to view the pre-formatted text that will be inserted into your text document,
select “Yes” and click on the "OK" button.

Question 19.2.2 asks if your SOP identifies data handing equipment and/or procedures
for processing, analyzing, compiling, and/or transmitting continuous monitoring data. on
the link in the right side screen to view the pre-formatted text that will be inserted into
your text document, select “Yes” and click on the "OK" button.

Question 19.2.3 asks if your SOP describes how continuous monitoring data will be
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formatted and entered (or prepared for uploading) into the SWMP Information
Management System. Click on the link in the right side screen to view the pre-formatted
text that will be inserted into your text document, select “Yes” and click on the "OK"
button.

Question 19.2.4 asks if your SOP conforms to the SWAMP Information Management
System requirements for using standardized data sheets. Click on the link in the right side
screen to view the pre-formatted text that will be inserted into your text document, select
“Yes” and click on the "OK" button.

Question 19.2.5 asks you to enter the name of the person who will be responsible for
management of the continuous monitoring data. Note that this name will be appended to
the sentence shown in the right side screen. Enter the person’s name and click on the
"OK" button.

Question 19.3.0 asks if you have a SOP for laboratory data management. Select “Yes”
and click on the "OK" button.

Question 19.3.0A asks you to type the title and SOP reference number. Note that this
information will be appended to the end of the sentence shown in the right side screen
and inserted into your text document. After your entry is made then click on the “OK”
button to continue.

Question 19.3.1 asks if the SOP describes what standard practices will be used for record
keeping and data tracking of laboratory data. Click on the link in the right side screen to
view the pre-formatted text that will be inserted into your text document, select “Yes”
and click on the "OK" button.

Question 19.3.2 asks if your SOP identifies data handing equipment and/or procedures
for processing, analyzing, compiling, and/or transmitting laboratory analytical data. on
the link in the right side screen to view the pre-formatted text that will be inserted into
your text document, select “Yes” and click on the "OK" button.

Question 19.3.3 asks if your SOP describes how field measurement data will be
formatted and entered (or prepared for uploading) into the SWMP Information
Management System. Click on the link in the right side screen to view the pre-formatted
text that will be inserted into your text document, select “Yes” and click on the "OK"
button.

Question 19.3.4 asks if your SOP conforms to the standardized list of analytes necessary
to meet the requirements of the SWAMP Information Management System. Click on the
links to additional information if you need it. Also, click on the link in the right side
screen to view the pre-formatted text that will be inserted into your text document, select
“Yes” and click on the "OK" button.

Question 19.3.5 asks you to select whether you SOP covers only chemical and/or
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biological analytes or only toxicology tests or both. . Click on the link in the right side
screen to view the pre-formatted text that will be inserted into your text document, select
“Chemical and/or bacteria and also toxicity” and click on the "OK" button.

Question 19.3.5.1 asks if your SOP conforms to the SWAMP Management Information
System Analytical Data Template. Click on the links to additional information if you
need it. Also, click on the link in the right side screen to view the pre-formatted text that
will be inserted into your text document, select “Yes” and click on the "OK" button.

Question 19.3.5.2 asks if your SOP conforms to the SWAMP Management Information
System Toxicity Analysis Data Template and Toxicity Data Format. Click on the links to
additional information if you need it. Also, click on the link in the right side screen to
view the pre-formatted text that will be inserted into your text document, select “Yes”
and click on the "OK" button.

Question 19.3.6 asks you to enter the name of the person who will be responsible for
management of the laboratory data. Note that this name will be appended to the sentence
shown in the right side screen. Enter the person’s name and click on the "OK" button.

Question 19.4 asks if your SOP conforms to the SWAMP Information Management
System required fields in the station template. Click on the links to additional information
if you need it. Also, click on the link in the right side screen to view the pre-formatted
text that will be inserted into your text document, select “Yes” and click on the "OK"
button.

Question 19.5 asks if your SOP conforms to the SWAMP Information Management
System file and batch name convention. Click on the links to additional information if
you need it. Also, click on the link in the right side screen to view the pre-formatted text
that will be inserted into your text document, select “Yes” and click on the "OK" button.

Question 19.6 asks if your SOP conforms to the SWAMP Information Management
System requirements for specified fields for database comparability. Click on the links to
additional information if you need it. Also, click on the link in the right side screen to
view the pre-formatted text that will be inserted into your text document, select “Yes”
and click on the "OK" button.

Question 19.7 asks whether form entry or batch loading or both will be used to upload

data into the SWAMP Information Management System. Click on the link in the right

side screen to view the pre-formatted text that will be inserted into your text document,
select “Both” and click on the "OK" button.

Question 19.8 alerts you to the fact that you are finished entering information into
Element 19. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
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Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 19 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “19-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 19.

5.18 Element 20 — Assessment and Response

5.18.1 - Content Checklist for Element 20

In order to complete this section, you will need the following information:

e SOPs for field assessments and laboratory assessments with descriptions of who will
conduct them, when they will be conducted, how often they will be conduced, what
they will cover, and how any deficiencies found will be documented and corrected

5.18.2 - Instructions for Element 20

The first screen (20.0) provides a short menu of the types of assessments that you plan
with the proposed project. Select both of them and click on the "OK" button.

Question 20.1 provides a short menu of the types of field assessments that you plan to
make. Select all of them and click on the "OK" button.

Question 20.1.1.1 asks for the name of the responsible person for readiness reviews for
field assessments. Enter the person’s name and click on the "OK" button.

Question 20.1.1.2 asks you to describe when and/or how often readiness reviews will be
conducted. Useful information, that you may copy and paste with appropriate edits, is
provided in the right side screen. Enter your answer and click on the "OK" button.

Question 20.1.1.3 provides 4 typical types of readiness reviews. Click on the right side
link to read each of the pre-formatted answers and then check all that apply and click on
the "OK" button.

Question 20.1.1.4 asks for a description of how any problems that were noted during
readiness reviews will be documented and corrected, including who will be responsible
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for corrections and documenting them. Useful information, that you may copy and paste
with appropriate edits, is provided in the right side screen. Enter your answer and click on
the "OK" button.

Question 20.1.2.1 asks for the name of the person who will be responsible for field
activity audits. Enter that person’s name and click on the "OK" button.

Question 20.1.2.2 asks for a description of when and/or how often field activity audits
will be made. Useful information, that you may copy and paste with appropriate edits, is
provided in the right side screen. Enter your answer and click on the "OK" button.

Question 20.1.2.3.asks for a description of what types of procedures will be included in
field activity audits. . Useful information, that you may copy and paste with appropriate
edits, is provided in the right side screen. Enter your answer and click on the "OK"
button.

Question 20.1.2.4 asks for a description of how any problems that were noted during field
activity audits will be documented and corrected, including who will be responsible for
corrections and documenting them. Useful information, that you may copy and paste with
appropriate edits, is provided in the right side screen. Enter your answer and click on the
"OK" button.

Question 20.1.2.5 asks for the name of the person who has responsibility to stop sampling
activities in the event that a serious problem makes that a necessity and under what
conditions that authority could be used. Enter the person’s name and click on the "OK"
button.

20.1.3.1 asks for the name of the person who will be responsible for conducting post
sampling event reviews. Enter that person’s name and click on the "OK" button.

Question 20.1.3.2 asks for a description of when and/or how often post sampling event
reviews will be made. Useful information, that you may copy and paste with appropriate
edits, is provided in the right side screen. Enter your answer and click on the "OK"
button.

Question 20.1.3.3.asks for a description of what types of information will be included in
post sampling event reviews. Useful information, that you may copy and paste with
appropriate edits, is provided in the right side screen. Enter your answer and click on the
"OK" button.

Question 20.1.3.4 asks for a description of how any problems that were noted during post
sampling event reviews will be documented and corrected, including who will be
responsible for corrections and documenting them. Useful information, that you may
copy and paste with appropriate edits, is provided in the right side screen. Enter your
answer and click on the "OK" button.
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Question 20.2 provides a short menu of the types of laboratory assessments that you plan
to make. Select both of them and click on the "OK" button.

Question 20.2.1.1 asks for the name of the responsible person for reviews of laboratory
analytical data. Enter the person’s name and click on the "OK" button.

Question 20.2.1.2 asks you to describe when and/or how often laboratory analytical data
reviews will be conducted. Useful information, that you may copy and paste with
appropriate edits, is provided in the right side screen. Enter your answer and click on the
"OK" button.

Question 20.2.1.3 asks for a description of how any problems that were noted during
laboratory analytical data reviews will be documented and corrected, including who will
be responsible for corrections and documenting them. Useful information, that you may
copy and paste with appropriate edits, is provided in the right side screen. Enter your
answer and click on the "OK" button.

Question 20.2.1.4 asks for the name of the person who has responsibility to request re-
tests of laboratory analyses in the event that a serious problem makes that a necessity and
under what conditions that authority could be used. Enter the person’s name and click on
the "OK" button.

Question 20.2.2.1 asks for the name of the person who will be responsible for conducting
laboratory audits. Enter that person’s name and click on the "OK" button.

Question 20.2.2.2 asks for a description of when and/or how often laboratory audits will
be made. Useful information, that you may copy and paste with appropriate edits, is
provided in the right side screen. Enter your answer and click on the "OK" button.

Question 20.2.2.3 asks for a description of how any problems that were noted during
laboratory audits will be documented and corrected, including who will be responsible
for corrections and documenting them. Useful information, that you may copy and paste
with appropriate edits, is provided in the right side screen. Enter your answer and click on
the "OK" button.

Question 20.1.3.4 asks for a description of any relative laboratory proficiency tests that
are planned. Useful information, that you may copy and paste with appropriate edits, is
provided in the right side screen. Enter your answer and click on the "OK" button.

Question 20.3 alerts you to the fact that you are finished entering information into
Element 20. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next

question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
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“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 20 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “20-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 20.

5.19 Element 21 — Reports to Management

5.19.1 - Content Checklist for Element 21

In order to complete this section, you will need the following information:

A list of all the reports to management that you plan to prepare.
A list of who will be responsible for each type of report.

A list of when each report will be distributed.

A list of to whom each type of report will be distributed.

5.19.2 - Instructions for Element 21

The first screen (21.0) provides a list of 8 common types of reports to management plus
“Other” which allows you to enter your own report description. For each report type that
you select you will be asked to provide specific information about who will be
responsible for it, when it will be distributed, and to whom it will be distributed.
Therefore, for this exercise select only two reports: #1 — Final Report and #4 Monthly
Status Reports. Check each of these and click on the "OK" button.

Question 21.1 asks you to provide details about submitting the final report to
management. Useful information, that you may copy and paste with appropriate edits, is
provided in the right side screen. Enter your answer and click on the "OK" button.
Question 21.4 asks you to provide details about submitting the monthly reports to
management. Useful information, that you may copy and paste with appropriate edits, is
provided in the right side screen. Enter your answer and click on the "OK" button.

Question 21.10 alerts you to the fact that you are finished entering information into
Element 21. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
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question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 21 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “21-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 21.

5.20 Element 22 — Data Review, Verification, and Validation

5.20.1 - Content Checklist for Element 22

In order to complete this section, you will need the following information:

e A list of people who will have primary responsibility for data review, data
verification and data validation.

SOP for data review.

SOP for data verification.

SOP for data validation.

A list of Measurement Quality Objectives from Element 7.

A list of QA/QC requirements from Elements 14, 15, 16, and 17.

5.20.2 - Instructions for Element 22

The first question (22.1) asks if you plan to conduct a review of the data from the
proposed project. Click on the link in the right side screen to read the pre-formatted text,
click on “Yes” and click on the "OK" button.

Question 22.2.1 asks for the name of the person who will be responsible for data review.
Enter the person’s name in the space provided and click on the "OK" button.

Question 22.1.2 asks if the data review will include typical kinds of error checks. Click
on the link in the right side screen to read the pre-formatted text, click on “Yes” and click
on the "OK" button.

Question 22.1.3 asks if the data will be reviewed against the Method Quality Objectives

that were documented in Element 7. Click on the link in the right side screen to read the
pre-formatted text, click on “Yes” and click on the "OK" button.
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Question 22.1.4 asks if the data will be reviewed against the QA/QC requirements that
were documented in Elements 14, 15, 16, and 17. Click on the link in the right side
screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.

Question 22.1.5 asks if the data will include checking field sampling and measurement
data. Click on the link in the right side screen to read the pre-formatted text, click on
“Yes” and click on the "OK" button.

Question 22.1.6 asks if the data will include checking laboratory analytical data. Click on
the link in the right side screen to read the pre-formatted text, click on “Yes” and click on
the "OK" button.

Question 22.2 asks if you plan to conduct data verification. Click on the link in the right
side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.

Question 22.2.1 asks for the name of the person who will be responsible for data
verification. Enter the person’s name in the space provided and click on the "OK" button.

Question 22.3 asks if you plan to conduct data validation. Click on the link in the right
side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.

Question 22.3.1 asks for the name of the person who will be responsible for data
validation. Enter the person’s name in the space provided and click on the "OK" button.

Question 22.4 asks if you plan to separate the data into categories that can be used to
make decisions. Click on the link in the right side screen to read the pre-formatted text,
click on “Yes” and click on the "OK" button.

Question 22.5 alerts you to the fact that you are finished entering information into
Element 22. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 22 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “22-

QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.
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After the file has been saved then that completes the work with Element 22.

5.21 Element 23 — Verification and Validation Methods

5.21.1 - Content Checklist for Element 23

In order to complete this section, you will need the following information:

e A list of people who will be responsible for data reviews and laboratory data reviews.
e A list of people who will be responsible for independently reviewing at least 10% of
the data and laboratory data.

5.21.2 - Instructions for Element 23

The first question (23.1) asks if many of the details of data verification and validation
were covered in Element 22. Click on the link in the right side screen to read the pre-
formatted text, click on “Yes” and click on the "OK" button.

Question 23.2 asks if all data records will be inspected visually and recorded as checked
by initials and dates. Click on the link in the right side screen to read the pre-formatted
text, click on “Yes” and click on the "OK" button.

Question 23.2.1 asks for the name of the person who will be responsible for the data
reviews. Enter the person’s name and click on the "OK" button.

Question 23.2.2 asks if at least 10% of the data will be independently checked. Click on
“Yes” and click on the "OK" button.

Question 23.2.3 asks for the name of the person who will be responsible for
independently reviewing the data. Enter the person’s name and click on the "OK" button.

Question 23.3 asks if the laboratory will check all of its data. Click on the link in the right
side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.

Question 23.3.1 asks for the name of the person who will be responsible for reviewing all
of the laboratory data. Enter the person’s name and click on the "OK" button.

Question 23.3.2 asks if at least 10% of the laboratory data will be independently checked.
Click on “Yes” and click on the "OK" button.

Question 23.3.3 asks for the name of the person who will be responsible for
independently reviewing the laboratory data. Enter the person’s name and click on the
"OK" button.

Question 23.4 asks for a description of how errors that involve data verification and
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validation will be handled and documented if any should be found. Click on the link in
the right side screen to view useful information that may be copied and pasted, with
appropriate modifications. Enter your answer in the left side screen and click on the "OK"
button.

Question 23.4.1 asks for the name of the person who will be responsible for reporting and
correcting any errors that may be found in the data. Enter the person’s name and click on
the "OK" button.

Question 23.5 asks for a description of how any data quality issues that may develop
during the project will be resolved. Click on the link in the right side screen to view
useful information that may be copied and pasted, with appropriate modifications. Enter
your answer in the left side screen and click on the "OK" button.

Question 23.5.1 asks for the name of the person who will be responsible for resolving any
issues that may be found during the verification and validation process. Enter the
person’s name and click on the "OK" button.

Question 23.6 asks if there are any SOPs, checklists, special equations, etc. that will be
appended to the QAPP. If there are you will be able to list them in a following question.
Select “No” and click on the "OK" button.

Question 23.7 alerts you to the fact that you are finished entering information into
Element 23. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 23 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “23-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 23.

5.22 Element 24 — Reconciliation With User Requirements
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5.22.1 - Content Checklist for Element 24

In order to complete this section, you will need the following information:
e A printed copy of your draft QAPP document files from Elements 1 — 23.

5.22.2 - Instructions for Element 24

The first question (24.1) asks you to reiterate your project’s objectives. This is a
restatement of your answer in Element 5.1. You may copy that statement from your 5-
QAPP.rtf document into the space in the left side screen or retype it. Additionally, an
example from the Sycamore Creek Monitoring Plan is available from a link in the right
side screen that you may copy and paste, with appropriate modifications. Enter you
answer and click on the "OK" button.

Question 24.2 asks you to select all of the sources of information that you plan to use to
support whether or not your objectives will have been met. Click on the link in the right
side screen to see the pre-formatted text that will be entered. Only sources of information
that you select will be entered into the pre-formatted text. Click on all of the sources of
information that apply and click on the "OK" button.

Question 24.3 asks if you will perform statistical analysis on any of the data. Select
“Yes” and click on the "OK" button.

Question 24.3A asks for a summary of which data will be statistically analyzed and what
types of statistical analysis will be applied. Click on the link in the right side screen to see
an example that may be copied and pasted, with appropriate modifications, in the space
provided for your answer and click on the "OK" button.

Question 24.4 asks if you will include tables and/or charts to present some of the data.
Select “Yes” and click on the "OK" button.

Question 24.1.1 asks for a description of which data will be presented in tables and/or
charts. You may enter your own description (remember the SWAMP Advisor
automatically generated tables for Elements 7, 12, 13, 14 and 16) or click on the link in
the right side screen to see an example that may be copied and pasted, with appropriate
modifications, in the space provided for your answer and click on the "OK" button.

Question 24.5 asks for a description of how limitations in data use (which may occur)
will be presented to data users. Click on the link in the right side screen to see an example
that may be copied and pasted, with appropriate modifications, in the space provided for
your answer and click on the "OK" button.

Question 24.6 asks for a description of how the data will be used in the context of various
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SWAMP components, including the SWAMP Information Management System. Click
on the link in the right side screen to see an example that may be copied and pasted, with
appropriate modifications, in the space provided for your answer and click on the "OK"
button.

Question 24.7 asks if additional evaluations will be used to determine whether the data
will meet the project’s objectives. Select “No” and click on the "OK" button.

Question 24.8 asks for the name of the person who will be responsible for evaluating the
data with respect to whether or not it supports meeting the project’s objectives. Enter the
person’s name and click on the "OK" button.

Question 24.9 alerts you to the fact that you are finished entering information into
Element 24. Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next
question asks if you want to save the draft text that you just reviewed to a “Rich Text
Format” (RTF) file. Select “Yes” and click on the “OK” button. As soon as you click the
“OK” button the SWAMP Advisor will compile your answers into a correctly formatted
document for Element 23 and send it to your browser. If you do not see this happen then
check Section 1.1 for solutions to the problem. Possible problems include your browser
not having the tool bar options tab checked to download documents, a pop-up blocker not
being deactivated, a security system such as in Internet Explorer’s Version 7 blocking the
file from view, etc.

Click on the “File” tab in the MS Word file, select “Save As” and name this file, “24-
QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP
files.

After the file has been saved then that completes the work with Element 24.

6.0 Glossary

Unless otherwise noted, the following definitions are from the Environmental Protection
Agency’s Glossary of Quality-Related Terms: http://www.epa.gov/quality/glossary.htm

Accuracy The closeness or agreement of the observed value or test
response to the true or acceptable reference value or the
test response from a reference method. It is influenced by
both random error (precision) and systematic error (bias).
The terms “bias” and “precision” are often used in lieu of
“accuracy”.
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http://www.epa.gov/quality/glossary.htm

Analytical Batch*

A group of 20 or fewer samples and associated quality
control that are processed by the same instrument within a
24-hour period (unless otherwise specified by method). An
analytical batch may comprise multiple sample batches.

Analytical Run*

The quantification of a single discrete sample or its
associated quality control.

Assessment

A general evaluation process used to evaluate the
performance, effectiveness and processes of a management
and/or technical system.

Batch

The collection of samples of the same group which is to be
analyzed in one test run or inspected together within a
specific time limit and traceable as a unit.

Bias

The constant or systematic distortion of a measurement
process that manifests itself as a persistent positive or
negative deviation from the known or true value. This can
result from improper data collection, poorly calibrated
analytical or sampling equipment, or limitations or errors
in analytical methods and techniques.

Blank

A specimen that is intended to contain none of the analytes
of interest and which is subjected to the usual analytical or
measurement process to establish a zero baseline or
background value.

Calibration

A comparison of a measurement standard, instrument, or
item with one having higher accuracy to detect, quantify,
and record any inaccuracy or variation; the process by
which an instrument setting is adjusted based on response
to a standard to eliminate the inaccuracy.

Calibration Standard

Reference solution of known value used to correct an
instrument reading.

Comparability

A measure of the confidence with which one data set,
element, or method can be considered as similar to
another.

Completeness

A measure of the amount of valid data obtained from a
measurement system.
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Continuing Calibration
Verification*

A periodic standard used to assess instrument drift
between calibrations.

Control Limit

The variation in a process data set expressed as plus/minus
standard deviations from the mean, generally placed on a
chart to indicate the upper and lower acceptable ranges of
process data and to judge whether the process is in or out
of statistical limitations.

Corrective Action

Any measures taken to rectify conditions adverse to
quality and/or to eliminate the causes of an existing
nonconformity, defect, or other undesirable situation in
order to prevent reoccurrence.

Data Quality Objectives

Qualitative and quantitative statements derived from the
DQO Planning Process that clarify the purpose of the
study, define the most appropriate type of information to
collect, determine the most appropriate conditions from
which to collect that information, and specify tolerable
levels of potential decision errors.

Data Validation

An analyte- and sample-specific process that evaluates the
information after the verification process (i.e.,
determination of method, procedural, or contractual
compliance) to determine analytical quality and any
limitations.

Data Verification

The process of evaluating the completeness, correctness,
and conformance/compliance of a specific information set
against the method, procedural, or contractual
specifications for that activity.

Drift*

The directional deviation in instrument response from its
set or reference value over a period of time.

Equipment Blank

An aliquot of reagent water that is subjected in the
laboratory to all aspects of sample collection and analysis,
including contact with all sampling devices and apparatus.
The purpose of the equipment blank is to determine if the
sampling devices and apparatus for sample collection have
been adequately cleaned before they are shipped to the
field site. An acceptable equipment blank must be
achieved before the sampling devices and apparatus are
used for sample collection.
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Field Blank

A clean analyte-free sample which is carried to the
sampling site and then exposed to sampling conditions,
returned to the laboratory, and treated as an environmental
sample. This blank is used to provide information about
contaminants that may be introduced during sample
collection, storage, and transport.

Field Duplicate
(Co-located)

An independent specimen collected from the same point in
time and space as the previous specimen.

Field Duplicate
(Subsample)

A test specimen that is homogenized before being divided
into two or more portions with the same laboratory
analyzing all portions.

Field Measurements

Those activities associated with performing analyses or
measurements in the habitat being examined.

Holding Time*

The period of time a sample may be stored following
collection, preservation, extraction, or analysis. While
exceeding the holding time does not necessarily negate the
veracity of analytical results, it causes the qualification of
any data not meeting all of the specified acceptance
criteria.

Indicators

Items, elements, or measures used to determine or identify
a basic condition or how well a process or program is
meeting its objectives.

Intercomparison

An exercise in which samples are prepared and split by a
reference laboratory, then analyzed by one or more testing
laboratories and the reference laboratory. The
intercomparison, with a reputable laboratory as the
reference laboratory, serves as the best test of the precision
and accuracy of the analyses at natural environmental
levels.

Interference

An element, compound, or other matrix effect present in a
sample which disturbs the detection of a target analyte
leading to inaccurate concentration results for the target
analyte.
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Internal Standard

Pure analyte(s) added to a sample, extract, or standard
solution in known amount(s) and used to measure the
relative responses of other method analytes that are
components of the same sample or solution. The internal
standard must be an analyte that is not a sample
component.

Laboratory Blank

An aliquot of reagent water that is treated exactly as a
sample including exposure to all glassware, equipment,
solvents, reagents, internal standards, and surrogates that
are used with samples. The laboratory blank is used to
determine if method analytes or interferences are present
in the laboratory environment, the reagents, or the
apparatus.

Laboratory Duplicate

Two or more representative portions taken from one
homogeneous sample by the analyst and analyzed in the
same testing facility.

Laboratory Control Sample

A specimen of known composition prepared using
contaminant-free reagent water, or an inert solid, that is
spiked with the analyte of interest at the midpoint of the
calibration curve or at the level of concern; and then
analyzed using the same preparation, reagents, and
analytical methods employed for regular specimens and at
the intervals set in the Quality Assurance Project Plan.

Matrix The material of which the sample is composed or the
substrate containing the analyte of interest, such as
drinking water, waste water, air, soil/sediment, biological
material, etc. Also called medium or media.

Matrix Spike A test specimen prepared by adding a known concentration

of the target analyte to a specified amount of a specific
homogenized specimen where an estimate of the target
concentration is available and subjected to the entire
analytical protocol.

Matrix Spike Duplicate

A sample prepared simultaneously as a split with the
matrix spike sample with each specimen being spiked with
identical, known concentrations of targeted analyte.
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Measurement Quality
Objectives

The individual performance or acceptance goals for the
individual Data Quality Indicators such as precision or
bias.

Method

A procedure, technique, or tool for performing a scientific
activity.

Method Blank

A blank prepared to represent the sample matrix as closely
as possible and analyzed exactly like the calibration
standards, samples, and quality control (QC) samples.
Results of method blanks provide an estimate of the
within-batch variability of the blank response and an
indication of bias introduced by the analytical procedure.

Minimum Level

The lowest level at which the entire analytical system must
give a recognizable signal and acceptable calibration point
for the analyte. It is equivalent to the concentration of the
lowest calibration standard, assuming that all method-
specified sample weights, volumes, and cleanup
procedures have been employed.

Parameter

A statistical quantity, usually unknown, such as a mean or
a standard deviation, which characterizes a population or
defines a system.

Performance Based
Measurement System

A set of processes wherein the data needs, mandates, or
limitations of a program or project are specified and serve
as criteria for selecting appropriate methods to meet those
needs in a cost-effective manner.

Precision

A measure of mutual agreement between two or more
individual measurements of the same property, obtained
under similar conditions.

Quality Assurance

An integrated system of management activities (planning,
implementation, assessment, reporting, and quality
improvement) that focuses on providing confidence in the
data or product by ensuring that it is of the type and worth
needed and expected by the client.
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Quality Control

The overall system of technical activities that measures the
attributes and performance of a process, item, or service
against defined standards to verify that they meet the stated
requirements established by the customer; operational
techniques and activities that are used to fulfill
requirements.

Quality Assurance Officer

The individual designated within an organization having
management oversight and responsibilities for planning,
documenting, coordinating, and assessing the system
effectiveness for ensuring the value of the work.

QAPP

A document that describes the intended technical activities
and project procedures that will be implemented to ensure
that the results of the work to be performed will satisfy the
stated performance or acceptance criteria. The amount of
information presented and the planned activities to ensure
the value of the work will vary according the type of study
and the intended use of the data.

QMP

A document that describes an organization’s system in
terms of its organizational structure, policy and
procedures, staff functional responsibilities, lines of
authority, and interfaces for those planning, implementing,
documenting, and assessing all activities conducted.

Sample Batch

Twenty or fewer field samples prepared and analyzed with
a common set of QC samples.

Sensitivity

The capability of a method or instrument to discriminate
between measurement responses representing different
levels of a variable of interest.

Spike

A known quantity of an analyte added to a sample for the
purpose of determining recovery or efficiency (analyst
spikes), or for quality control (blind spikes).

Split

Two or more representative portions taken from one
specimen in the field or in the laboratory and analyzed by
different analysts, methods, or laboratories.
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Standard Deviation

The measure of the dispersion or imprecision of a series of
accepted results around the average, equal to the square
root of the variance.

Standard Operating A written document that details the method for an

Procedure operation, analysis, or action with thoroughly prescribed
techniques and steps and that is officially approved as the
method for performing certain routine or repetitive tasks.

Surrogate A pure substance with properties that mimics the analyte

of interest (organics only) and which is unlikely to be
found in environmental samples. It is added into a sample
before sample preparation.

Travel Blank*

Analyte-free water placed in the same type of container as
its associated field samples. It may be pre-preserved prior
to shipment, but is not opened during the sample
collection. Consequently, it helps isolate contamination
associated with sample transport.

* SWAMP Quality Assurance Program Definition
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